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Foreword

About this manual

Thank you for using VisTitle! VisTitle is a product of Beijing VideoStar Shichuang Technology Co.
Ltd. VisTitle is the ideal platform for use with EDIUS and is designed to help EDIUS users create
text and clip files in High and Standard Definition (HD/SD) environments.
This User Manual is designed to teach users how to employ the VisTitle software and the various
functions that are supported by it, including how to create television titles, how to roll titles,
create title effects and much more.
If you are using Acrobat Reader to view this User Manual, we recommend that you make use of
the Bookmark function.
To download the latest version of this document, please log on to www.hkvisdom.com.
Modifications to this document will be strictly at the discretion of Videostar Company.

http://www.hkvisdom.com/


Chapter One Overview of functions

1.1. Start Project Screen

Open VisTitle independently, Start Project screen will appear.

Functions



1) History Project
Show latest project.

2) Layout List
Show layout list of the selected history project.

3) Buttons
New Project: click the button to open System Format Select screen
Browse Project: allows you to browse and open local project
Open Project: allows you to open the selected history project
Close: exit VisTitle software

1.2. Select Format Screen

Click on the “New Project” button, System Format Select screen will appear.

Four functions can be performed:
1) Choosing a format.

For example, PAL D1 50i or PAL Full HD 1080/50i 16:9.
Note: if one format is frequently used it can be set as the default format.
Three functions can be performed:

2) Add custem format
Choose “Custom” format.



Set format parameters then click the “Add” button marked in red in the image above.

3) Set Title parameters.

Custom parameters can be set by clicking on "Custom", setting parameters, and then clicking on
[Save as Default Parameters].
4) Enable 3D Stereoscopic

Note: If, once in VisTitle, the format needs to be changed, you can:
1. Use the shortcut Ctrl+Shift+P



2. Click on the [Document Settings] button.Once the format has been chosen, click on

[OK] to proceed.

The Main Interface screen is divided into the following parts:
 Menu Bar - this is the main tool bar
 Layout List- lists all layouts
 Edit Screen - allows you to directly edit objects and text
 Timeline Window - shows duration items in every layout page
 Properties Window - allows you to edit the properties of objects and text
 Status Bar - provides basic layout information and interface tools



1.3. The Menu Bar

1.3.1. File Menu

New Project create new project
Open Project open existing project
Browse Project allow you to browse and open local

project
Save Project save project
Save As Project save project as [new name]
Document Settings set project settings
Recent Project recent projects are listed

Import Layout from Project Import layout from other project
Export Current Layout Full Screen Picture export current layout as full-screen

picture
Export Current Animation Frame Picture export current frame of the movie as

picture
Export Current Layout Animation export current layout as animation

(*.vxmovie file/image sequence/*.mov
file/*.avi file)



Export all Layouts Export all layouts as picture/dynamic
layout file/still layout file (dynamic/still
means that when the layout is dragged
to EDIUS timeline, the status is dynamic
or still)

Export Project include reference files Export referenced files included in the
project, such as image, animation, and
etc.

Manage Reference Files in Current Layout Manage referenced files in the current
layout in reference file management
interface.

Manage Reference Files in Project Manage referenced files in the project
in reference file management interface.

Exit Exit software



1.3.2. Edit Menu

Undo Undo action
Redo Restore undone action
Select All Select all objects in the layout
Make Group Create a group of objects
Ungroup Separate a group of objects
Up Move selected object up
Down Move selected object down
Move to Top Move selected object to top
Move to Bottom Move selected object to bottom
Mirror Vertical Vertically mirror selected object
Mirror Horizontal Horizontally mirror selected object
System Option Open the system option window
Keyboard Preset Open the shortcut key preset window



1.3.3. Scroll Menu

Still/Animation Layout Set as still or animation
Roll Set roll-to-top mode
Crawl Left Set crawl-to-left mode
Crawl Right Set crawl-to-right mode
Add One Screen Add one screen
Add Half Screen Add half screen
Delete One Screen Delete one screen
Delete Half Screen Delete half a screen
View Scroll Line Show/Hide Roll/Crawl Line



1.3.4. Edit View Menu

View Ruler Show/Hide Ruler
View Grid Show/Hide Grid
View Safe Area Show/Hide Safe Area
View Cross Line Show/Hide Crossline
Enable Guideline Show/Hide snap line
Enable Hover Objects Show/Hide object hover indicator
Black Background Set black background
Checkboard Background Set grid background
Background Settings Open the background settings window
Show Full Color Show fill-in signal only
Show Alpha Color Show Alpha signal only
Show Fill Color Show all the color
Zoom to Fit Zoom the edit window to fit
Actual Size Set the editing area to actual size
Zoom In Zoom in the edit window
Zoom Out Zoom out the edit window
Zoom Selection Scale the size of the selected object in the

editing area



1.3.5. Timeline Menu

Selection In Point Align to Timeline Position Align In Point of selected object with timeline
pointer position

Selection Out Point Align to Timeline Position Align Out Point of selected object with
timeline pointer position

Selection In Point Alignment Align multiple selected objects by the In Point
on the timeline

Selection Out Point Alignment Align multiple selected objects by the Out
Point on the timeline

Trim Objects In Point to Timeline Position Trim the In Point of the selected object to the
timeline pointer position

Trim Objects Out Point to Timeline Position Trim the Out Point of the selected object to
the timeline pointer position

To Previous Edit Position Move the timeline pointer to the previous
edit position

To Next Edit Position Move the timeline pointer to the next edit
position

To Previous Edit Position of Selected Object Move the timeline pointer to the previous
edit position of the selected object

To Next Edit Position of Selected Object Move the timeline pointer to the next edit
position of the selected object



Track Layer matched with Object Layer Make the order of track layer and object layer
consistent

Timeline Auto Snap Enable/Disable automatic snap of timeline
Enable Hover Objects Show/hide object hover indicator
Expand/Collapse All Tracks Expand/Collapse all the tracks
Show/Hide Track Header Show/Hide track header
Show/Hide Aux Child View Show/Hide the auxiliary timeline window
Zoom to Fit Set timeline zoom to appropriate
Zoom In Zoom in timeline
Zoom Out Zoom out timeline
Zoom Selection Zoom selected objects on timeline

1.3.6. WindowMenu

Layout List Window Show/Hide layout list window
Timeline Window Show/Hide timeline window
Property Window Show/Hide property window
System Library Window Open/Close system library window
Edit View Only Mode Show Edit View only
Edit View/Effect View Mode Switch between graphics and text editing

mode and effect editing mode
Scroll Editing Mode Switch to scroll editing mode
Template Editing Mode Switch to template editing mode
Reset UI Reset editing UI
Reset Text Props Reset font property
Reset Shader Style Reset coloring property



1.3.7. Help Menu

View Quick Guide Open VisTitle Quick Guide
View User Manual Open VisTitle User Manual
Online Help Online Help
Send Feedback with E-Mail Send feedback via Email
Check for Updates Check if there is update available
Product Website Open product website
About Open About window

1.3.8. Object Toolbar

Select: choose an item Text: create horizontal text

Text: create vertical text Morph Text: create multidimensional
text

Curve Text: create curved text Shape: create object of certain shape

Shape: create object of circle Line: create lines

Bezier: create Bezier curves PaintStroke



Image: create image Clock: create clock

Title PlugIn：Create PlugIn object

1.3.9. Effect Toolbar

Select Translate: move the object

Rotate: rotate the object Scale: adjust size

Pivot: Enable Pivot Setting Tool Transparency

Create Freehand Path Create Bezier Path

Create Ellipse Path Pan

Orbit Dolly

This menu will appear when shifting to Effect Mode (shortcut F10).

1.4. Text Editor Toolbar

The Text Editor Toolbar allows you to set text parameters:

Font

Italics

Bold

Underline

Height

Width

Lock: lock height-width ratio

Align Left



Align Center

Align Right

Line Range

Character Range

Arrange: present text horizontally or vertically

Render: apply effects to whole text or to individual characters

Show/Hide Text Editor advanced functions

Enter left-right

Enter right-left

Enter top-down

Enter bottom-up

Font Mode

Fill Mode

Set vertical shear effect

Set horizontal shear effect

Small Caps

Unconstraint

Constraint



1.5. Layout List

Use the Layout List to quickly edit several titles.
Frequent operations are:
View: click on a Layout to make it appear on the
Edit Screen

Add Layout: Click button to add layout

Insert Layout: Click button to add a layout

below

Delete Layout: Click button to delete layout

or right-click on layout and choose Delete

Layout List right-click context menu:
Append: adds layout
Insert: inserts layout
Delete: deletes layout
Copy: copy layout
Cut: cut layout
Paste: paste layout
Up
Down
Move to Top:move layout to front
Move to Bottom:move layout to end
Prev Screen: pageup
Next Screen: pagedown
Head Screen: home
Tail Screen: end



1.6. Graphics (still) Editing Mode

Right-click on the Edit Screen
1. The following context menu will appear

Paste
Export all text of current layout to text page
View Ruler
View Grid
View Safe Area
View Cross Line
Enable Guideline
Enable Hover Objects
Balck Background
Checkboard Background
Background Settings
Show Full Color
Show Alpha Only
Show Fill Color

2. Object context menu



Make Group
Ungroup
Up
Down
Move to Top
Move to Bottom
Lock/Unlock
Visible/Invisible
Edit
Cut
Copy
Paste
Delete
Paste To Group
Copy Shader Style
Paste Shader Style
Scale ShaderStyle Parameter
Boolean
Mix Option
Align Objects
Center Object Pivot
Mirror Vertical
Mirror Horizontal
Reset Morph Text
Text Block
Save Object as Picture

1.6.1. Control Panel

The Control Panel is used to operate items placed in the timeline tracks. Functions from left to
right:

Choice Head - move to the start of chosen track

Choice Tail - move to the end of chosen track

Play Start

Play



Loop - continuously replay

To Home

To End
Left Time Code: current play time
Right Time Code: total play time.

1.6.2. Edit View Toolbar

Switch between still Edit View
and Effects View

Left-Aligned:Align selected objects
to the left

Right-Aligned: Align selected
objects to the right

Top-Aligned: Top-align selected
objects

Bottom-Aligned: Bottom-align
selected objects

Horizontally Center-Aligned:
Align selected objects horizontally
in the center

Vertically Center-Aligned: Align
selected objects vertically in the
center

Align to the Screen’s Horizontally
Center: Align selected objects to
the horizontal center of the
screen

Align to the Screen’s Vertical
Center: Aligns selected objects to
the vertical center of the screen

Horizontally Equidistant: Arrange
selected objects horizontally and
equidistantly

Vertically Equidistant: Arrange
selected objects vertically and
equidistantly

Make Same Width: Make selected
objects have the same width

Make Same Height: Make
selected objects have the same
height

Make Full Screen Size: Make the
selected object display in full
screen

Display ratio Zoom to fit: Zoom to fit

Sync Video Background with
NLE: Sync video in NLE as
background

Video Background: Video
background

Black Background/Checkboard
Background: Switch background

Export

Option

1.7. Effect Editing Screen

Press the [Effects Editing Screen] button (or type F10) to shift from the Graphics (Still) Editing



Screen. Here you can set object keyframes.

Adjusting screen angle:
a. To change angle, hold [Alt], left-click and drag mouse.
b. To reset angle, hold [Alt] and double-click.

1.7.1. Right-Click Menu of Each Effect

When using the displacement function, right-click for the following context menu:
Toggle Animation
Insert Keyframe
Delete Keyframe
Go to Previous Edit Position
Go to Next Edit Position
Reset Keyframe
Reset 3D Transform
Smooth Vertex
Sharp Vertex
Speed Normal
Speed Up
Speed Down
Ease in out
Set Line With Previous Keyframe
Set Line With Next Keyframe
Invert Keyframe List
Uniform Keyframe List
Reset Keyframe List

When using the rotate function, right-click for the following context menu:



Toggle Animation
Insert Keyframe
Delete Keyframe
Go to Previous Edit Position
Go to Next Edit Position
Reset Keyframe
Reset 3D Transform
X rotate value
Y rotate value
Z rotate value
Invert Keyframe List
Uniform Keyframe List
Reset Keyframe List

When using the scale function, right-click to see the following context menu:
Toggle Animation
Insert Keyframe
Delete Keyframe
Go to Previous Edit Position
Go to Next Edit Position
Reset Keyframe
Reset 3D Transform
X Scale value
Y Scale value
Z Scale value
Invert Keyframe List
Uniform Keyframe List
Reset Keyframe List

When using the Pivot function, right-click to see the following context menu:



Toggle Animation
Insert Keyframe
Delete Keyframe
Go to Previous Edit Position
Go to Next Edit Position
Reset Keyframe
Reset 3D Transform
Invert Keyframe List
Uniform Keyframe List
Reset Keyframe List

When using the Alpha function, right-click for the following context menu:
Toggle Animation
Insert Keyframe
Delete Keyframe
Go to Previous Edit Position
Go to Next Edit Position
Reset Keyframe
Reset 3D Transform
Invert Keyframe List
Uniform Keyframe List
Reset Keyframe List

Keyframe context menu
Cut
Copy
Paste Value
Delete
Reset
Constant
Speed Normal
Speed Up
Slow Down
Ease in out
Custom

1.7.2. Effect View Toolbar



Toggle Animation Insert keyframe in current timeline
position

Delete keyframe in current timeline
position

Go to Previous key frame position or
object head position

Go to next key frame position or
object tail position

Speed Normal

Speed Up Speed Down

Ease in out Reset keyframe in current timeline
position

Reset 3D transform in current
timeline position

3D Effect view type

View 3D Horizon Display ratio

Zoom to Fit Sync Video Background with NLE:
Sync the video in NLE as background

Video Background Black Background/Checkboard
Background

Export Option



1.8. Properties Window

1.8.1. Property Tab

The Properties Window has five tabs:
Property, Shader, Effect, Text and Roll/Crawl.
Name/Describe: view selected object and
describe
Mix Style: select Mix Normal/Mix Penetrate
Render as new layer
Position: view position, make change
Rotation: view rotate angle, make change.
Scale: view scale parameters, or change

value. Left-click on , changing to , scale

XY change simultaneously.
Shear: view shear value, or change.
Pivot: view pivot position, or make change.

Reset: reset selected value.

Reset All:By

clicking on it will reset all values, but doesn't
affect values in sub screen.
Sub Window: marked place in the picture
left.
If choosing different object, sub window will
appear different accordingly.

Set parameters by:
a. Clicking on the field and typing in the numbers
b. Dragging the cursor over the field



1.8.2. Shader Tab

Shader preview

Shader Style drop-down list

Properties list: Face, Outline, Shadow,
Depth,Frame

Add

Insert

Delete

Move Up

Move Down

 You can set specific parameters in the
properties list.

 You can also use preset Shader
templates

 Set Dynamic Texture and Masking, found
at the lower half of the tab.

Use the or button to add Face, Edge, Shadow or Depth



Use the button to remove Face, Edge, Shadow or Depth

Set order by clicking on the and buttons

Set Shader style by choosing from the drop-down list.



1.8.3. Effect Tab

To the left: 3D Transform, 2D Pan

and Screen In/Out areas

Expand

Reset

Fold/Expand

Delete

Save

Lock X and Y axis scaling

Screen In/Out area

Choose In method

Choose Stay method

Choose Out method

Add a default length

effect to the selected object

Add an effect as long as

the object to the selected object

Refresh the effects

template library

Icon dispaly/Text details

display

Setting screen In effect:

Click , choose an effect from the templates, then click .



Use the same method to apply [Stay] and [Out] effects.

1.8.4. Text Tab

Whole text Line by line text



Edit text options:
Whole text Line by line text

New Open

Save Save As

Find and Replace Create text

Create line by line text Create one line text

Replace All Replace

Tools Option

Roll/Crawl text editor menu:



Set Title: sets chosen text as Title
Set Cont.: sets chosen text as content
Select Title: pick out Titles
Select Cont.: pick out content
Title-Cont.: sets space between title and content
Cont.-Title: sets space between content and title
Cont.-Cont.: sets space between content and content
Hor. Apply: applies horizontally
Ver. Apply: applies vertically
At the bottom of the tab you can see the list of texts that are in the Edit Screen.
Left-click to edit.



1.8.5. Roll/Crawl Tab

Roll In: set role in method
Roll Out: set roll out method
Custom: set roll time
Loop: set loop time and count
Speed Down: reduce roll speed.
Liner: apply liner effect
Ruler: set ruler size
Full: restore liner to full screen
ScrollArea:
Ruler: set roll limits
Full: set ruler to full screen
Left/Right/Top/Bottom: set roll limits
Head/Tail Fade Pixel: set head/tail in/out
position
Mask: apply mask effect
Invert: apply invert effect
Blur: set blur parameters

1.9. Timeline Window

Timeline Window options:

Set track as Visible/Invisible Show/Hide object effect tracks

Enable 3D transform Lock object to prevent editing



:
Adjust the Timeline using the bar shown or right-click on the timeline, then drag the cursor.
Click on the bar-button at the very left of the Timeline to open the Templates Library.
3D Transform and Dynamic Texture tracks:

Enable effect options
Enable/Disable 3D Transform Keyframe points.
Go to previous Keyframe
Add/Remove Keyframe
Go to next Keyframe

Right-click on an object track to see the context menu:

Enable Timeline Autosnap Expand all tracks



Up
Down
Move to Top
Move to Bottom
Lock/Unlock
Visible/Invisible
Render as new layer
Rename
Edit
Set Object Duration
Cut Effect
Copy Effect
Paste Effect
Delete Effect
Copy 3D Transform
Paste 3D Transform
Reset 3D Transform
Copy All
Paste all
Reset to default

Right-click on an effect track to see the context menu:

Lock/Unlock
Enable/Disable
Show animation track only
Cut
Copy
Paste
Overlay
Delete
Reset
Invert All Keyframe
Uniform All Keyframe
Head Fade In



Tail Fade Out
Fade

Right-click on a text effect track to see the context menu:

Enable Area
Add Area
Delete Area
Play by char (in)
Play by char(out)
Play by line (in)
Play by line (out)
Play by Text
Frequency value
Uniform Area
Reset Area

Right-click on a keyframe marker to see the context menu:



Cut
Copy
Paste Value
Delete
Reset
Constant
Speed Normal
Speed Up
Speed Down
Ease in out
Custom

Right-click the Dynamic Texture track to see the context menu:



Modify
Fill Fit
Add
Insert
Cut
Copy
Overlay
Paste
Delete
Speed
Delete All
Select All

Set Dynamic Texture speed by choosing from the speed list.

Right-click on an empty track in the Timeline to see the context menu:
Track Layer Matched with Object Layer
Timeline Auto Snap
Enable Hover Objects
Expand/Collapse All Tracks
Show/Hide Track Header
Show/Hide Aux Child View
Show Timeline Pointer
Zoom fit (you can also double-click on the
timeline)
Keyframe Position Automatic Scale

1.10. Template Library



Template Library options:
Add list Delete list
Import template Export template

Black Background/Checkboard Background

Use the Zoom In/Out bar or [Zoom In/Out] buttons to zoom in/out of the template library.
From the template Menu Bar you can choose different template catalogues, such as Shader
Templates or Image Templates.

Changing template names:
Method 1: double-click on the template name, enter a new name

Method 2: right-click on the template and choose "Rename" from the context menu



Saving a still template as an dynamic template: right-click on the still template and choose "Save
as dynamic template". You can also save a dynamic template as a still template.

Example:



1.11. System Library

System Library options:
Add list Delete list
Rename Move up
Move down Add file
Delete file Apply file
Import file Export file
Refrest System Library

Right-click on an empty space (left context menu), or on a file (right context menu) for options:



Add
Delete
Rename
Apply
Locate File in Explorer
Move Prev
Move Next
Move Selection to
Copy Selection to
Import
Export
Refresh
Black Background
Grid Background
Small Icon
Middle Icon
Large Icon

To delete a file either:
a. Select a file, then press [Delete] on the keyboard or right-click and choose delete from the

context menu.

b. Select a file and press the button.
To add a file either:

a. Press on , or double-click and choose a location to import from.
b. Right-click, then choose "Import" from the context menu.
To edit a template name:
1. Choose a catalogue

2. Press on the [Rename] button, then enter a new name



3. Press [OK] to confirm. Press [Cancel] to exit without changing name.



Chapter Two Create Object

VisTitle provides a large number of default objects, including shapes, Bezier shapes,
horizontal/morph/curve titles, images, animation, clock object,etc.

2.1. Operation flow

Most object creation follows the same basic operation flow:
1) In” Edit View”mode,select object type

2) In Still Mode, click on the object and adjust size.

Note: Hold [Ctrl] when adjusting to keep vertical/horizontal size proportional.
3) Release object.



2.2. Shapes

 Following the basic operation flow, other shapes can be created.
 Property

In the lower half of the Properties Window
you can find the shape's special properties.
Activate/Deactivate the [Fill] option to set
Line Width.
Choose object shape in the drop-down list.
Changes will also take effect in the Edit
Screen.

Shapes with Fill mode deactivated.

Changing shapes: rectangle to triangle
1) In the Edit Screen, click on the rectangle.



2) In the Properties Window drop-down list,
select Triangle

3) Object becomes triangle.

Shapes with special properties:
1. Round Rectangle: set Radius parameters

2. Parallelogram: set Incline parameters

3. Star

Depth: set Depth between points
Face: set number of points
Reset Parameters: resets all parameters

Different Face parameters.



Different Depth parameters

4. Polygon: Face parameters set the number of sides

5. Pie Shape
Angle: set Pie angle and angle size

Example

Change angle

Change angle size

6. Line: set Line Width



2.3. Bezier Curve

The way to create a Bezier Curve and a shape is not the same as for other objects.
1) Click on [Bezier]

2) In Still Mode, set the Bezier Curve Anchor Points.

Note:
a. If you release the left mouse button straight away, both the Anchor and Control Points will be

created
b. If you keep the left mouse button pressed, you can first set the Control Points, and then

create the Anchor Point.
3) Join the last Anchor Point to the Start Point to complete the shape, or double-click/press ESC

to finish editing.
4) Double-click on the Bezier Curve to resume editing.
5) In edit mode, right click to see the following context menu



Smooth: smoothen lines between points
Sharp: sharpen lines between points
Delete: delete point
Lock/Unlock: prevents point from being edited
Set Start: set as start point
Enable/Disable: you can disable the point
Combine Move: move Control Points together or seperately
Line With Pre Node: Connect a straight line to the previous
node
Line With Next Node: Connect a straight line to the next
node
Close: close/open curve
Fill：Fill to full

2.4. Paintstroke

 Operation flow
1) Click Paintstroke button.

2) In the Editor Screen (still), left-click, and drag.

3) Release left mouse button, type ESC to exit.



Example:

2.5. Image

The operation flow for images and objects is similar, the only difference is that an image file
needs to be chosen in the Properties Window.
1) Click [Image] button

2) Set position and size in Still Mode. Release mouse cursor.
3) In the Properties Window select an image file (and Mask if needed).



Enable “3D Stereoscopic Image” and select
“Single/Dual”
Browse and select file and show file name
Show image height and width and
enable/disable “Origin”
Clip image
Set mask parameters and blur parameters
Whole Transpatency Control: Set whole
transpatency(disable when enabling “3D
Stereoscopic Image”)
The options are used when image object have
shader style property(Face, Outline, Shadow)

Specific Properties of 3D Stereoscopic Image

4) Example.



5) Double-click to Crop

6) The selected area will expand to the original image size

7) Press ESC to exit



2.6. Animation

Create Animation and Create Image operation flows are similar.
1) Click [Movie] button

2) In Still Mode, adjust size and position.
3) Release mouse cursor
4) In Properties Window select animation file and set parameters.

Present: set start frame
Trim In: set start time point
Trim Out: set end time point
Repeat: set repetitions
Origin: go to animated object original
position

5) Create complete
Using animation templates
A large number of preset animated objects are provided. Go to the templates library and
double-click on them to use them.



Note: If you double-click on an animation in the templates library when an animation has been
selected in the Edit Screen, it will be replaced.

2.7. Horizontal/Vertical Text

Normal-frame and Set-frame Text options are possible.
 Create Normal Text
1) Click [Horizontal Text] button

2) In Still Mode, adjust text size and position.

3) Enter text
Method 1: enter text

Method 2: copy and paste



Right click in text editing state and choose “Character Map” from the context menu.

4) Press ESC or double-click to exit
5) Double-click on text to continue editing
 Create Set-Frame Text
1) Click [Horizontal Text] button

2) In Still Mode drag cursor to desired frame size

3) Enter text. If text exceeds frame it will automatically move to the next line.



Text will automatically adjust when frame is shifted

4) Press ESC or double-click to exit
5) Double-click on the text to continue editing.
 Properties
Text Titles have many properties. Simply double-click on the desired text to start editing.



2.8. Morph Text

 Creating Morph Text uses the same operation flow as Normal Text.
1) Click [Morph Text] button

2) In Still Mode adjust text position, then enter text

3) Edit Morph Text curves (see also Bezier curve editor)

4) You can choose a morph text template from the Properties Window

5) Press ESC to exit. Example:



6) Double-click on text to resume editing.
 Morph Text control curves have three settings:

Separate - control curves independently
Same - control curves together
Inverse - curves do the inverse of each other
Set in two ways

1) Right-click on the text and then choose from the context menu



2) Select in the Properties Window

Example:

2.9. Curve Text

 Operation flow similar to normal text



1) Click [Curve Text] button

2) In Still mode use the Bezier curve method to create curves.

3) Enter text

4) You can also choose preset Curve Text styles from the template library.

5) Press ESC to exit. Example:



6) To resume editing, double-click on the text.

2.10. Clock Object

 To create:
1) Click on the "Clock" button.

Note: The "Clock" button offers various choices, from the drop-down menu you can select
"numbers" or "time code".
2) In the still editor window click on the starting position, then left click to drag the object to

the appropriate size.
3) Release the mouse button to complete operation.

4) Setting clock time parameters:
1. Using the system time, the default length can be adjusted freely, with the default set at 4

seconds.



2. Set countdown time as shown below. Default is set at 4 seconds.

Enter start time values. The default time is set as 0:00

Clock object parameters:



Timing Mode: System Time, Counting, Count
Down
Start time: set the start time. Select system
time to set the current system time as start
time.
End Time: Set end time
Play Duration: Set play duration
Stay Time: Set stay time after playing ends
Format: Select digital clock or dial clock.
Cut Time: switch to cut-time mode
Add Time: switch to accumulate-time mode
Display Format: Select the time display format
Millisecond: Millisecond
AM/PM
Quartz clock: Choose the clock
Front Label: Enter text before the clock
Back Label: Enter text after the clock
Language: Select language

Example:

2.11. Number Object

 To create:
1) Click on the "Number" button.



2) In the still editor window click on the starting position, then left click to drag the object to
the appropriate size.

3) Release the mouse button to complete operation.

Number object parameters
Start value: Set start numerical value
End value: Set end value
Stay Time: Set the stay time after playing ends
Decimal: set decimal number values
Minimun Digits: set smallest whole number
Display Format: Select the display format,
including numerical values, spelling,
percentage, etc.
Thousand Separator: Choose separator style
Front Label : Text to the left
Back Label : Text to the right
Language: Select language

Examples:



2.12. Timecode

 To create:
1) In the Object menu bar, click on the "Timecode" button.

2) In the still editor window click on the starting position, then left click to drag the object to
the appropriate size.

3) Release the mouse button to complete operation.

Timecode object parameters



Current Time Code:Timeline scale when
playing
Start Value: Custom timecode starting value
Play Duration: Set the playback length of
TimeCode objective
StayTime: Set the stay time of TimeCode
objective
Display Format: select format.
TimeCode Base
Front Lable: Text to the left
Back Lable: Text to the right

Set start time code:
1. Current Time Code mode:
Set to Current Time Code mode, modulate deviance, but default length are unchangeable.

2. Start Time Value mode:
When selecting Default Length, default length can be changed.

3. When selecting Keyframe Interpolation, end time code can change.

Examples:



2.13. Date Object

 To create:
1） Click on the "Date" button.

2） In the still editor window click on the starting position, then left click to drag the object to
appropriate size.

3） Release the mouse button to complete operation.

Date Object Parameters
Select “System Time” to set the current
system time as start time.
Select “User Define” to set time as needed.
Select the display format
Display Format:select date format
Language: Select language



Set Date
System time code:
Set to system date, and default date is unchangeable.

Define date code:
When selecting “User Define”, date can change.

Display Format
Choose a date format from the drop down list.



Examples:

2.14. Flag

 The create flag operation flow is similar to that of objects, and will not be presented here.

 Choose a flag from the Properties Window



The flag name and abbreviation will be
shown below.
To find a flag, enter the full name or
abbreviation into the "Find Name" field,
then press [Search].
Press [Origin] to place the flag in its default
position.

To find a flag, enter the full name or abbreviation into the "Find Name" field, then press [Find].



Edit flag:

In Flag Library left-click, select desired flag, then click .

In the pop-out Edit Frame, enter property parameters, click OK.

2.15. Object Group

Objects groups can be used to quickly manipulate multiple objects. Use groups to:
1) Rescale, rotate, etc., whole groups simultaneously
2) Use object groups' properties to produce different play effects.
 Make Group:
a. In the Edit Screen select multiple objects/text, then use the shortcut Ctrl+G
b. In the Edit Menu Bar choose [Make Group]
c. In the Edit Screen, right-click, then choose Make Group from the context menu



 Undo Group:
a. In the Edit Screen select the group, then use the shortcut Ctrl+U
b. In the Edit Menu Bar choose [Undo Group]
c. In the Edit Screen, right-click, then choose Ungroup from the context menu

2.16. Path Group

Path Groups use Boolean editing to create new, individualised object types.
 Choose multiple objects, then right-click or use shortcut key to apply Boolean



Boolean Union (Ctrl +'+') - merges two objects
Boolean Subtract (Ctrl +'-') - subtracts one object from the other
Boolean Intersect (Shift +'-') -intersect between objects remains
Boolean Xor (Shift +'+') - intersect between objects is removed
Example:

 To apply artistic effects to normal text, you can turn it into a Path Group.
1) Create normal text



2) Transform normal text into Path Group by typing Ctrl+P or right-click then choose "Text
Block"- "Text Block to Path Group"

3) Double-click on the Path Group to edit



Example

2.17. PathGroup to Object

1. Create objects and save them as PathGroup
Two objects



Adjust the position of objects and save them as Pathgroup with “Boolean” option. Please
check pathgroup section for detailed information.

2. Right click on the pathgroup and select “PathGroup to Shape” in the right click menu, or use
hotkey “Alt+P”.

3. After the above-mentioned operation, it will become a shape.



Chapter Three Applying Shader

3.1. Shader Properties

Shader properties incluce: Color, Texture, Linear sheen, Bitmat sheen, Bump bitmap, Concave,
and Bevel. An object's Face, Edge, Shadow and Depth have similar properties, allowing for
different combinations.

3.1.1. Colors

You can set Colors as: Color, Gradient, QuadGradient, BmpGradient
 Color

Reset

Set single color. Click to

see colors library.

RGB format

HSB format

The "Color" section has 32 preset colors, and 8 RGB Alpha combinations. To set color:
1. Choose one of the 32 preset colors
2. Use the cursor to pick a color from the palette
3. Set parameters in the RGB Alpha fields
4. Use the scroll bar
5. Use the pipette
 Gradient Color

Gradient preview

Under gradient preview,
select gradient type, count
and angle. Different
parameters can be set
depending on gradient type.

Set gradient



Fisrt click on Color Marker,
then pick color.
Use the same method as with
single color to set any color on
each Marker.

Adding, deleting and moving Color Markers:
Click under the gradient color bar to
add a Marker, drag to set position.
Press [Delete] to remove Marker.
Set the central position between
colors using the blured block over
the gradient color bar.
Change Count, Angle, and XY
parameters by imputing numbers
directly or dragging the cursor
left-right.

Gradient type
Choose gradient type from the drop down
list: Linear, Circle, Clock, Rose line or
Rectangle.

Linear gradient
In Linear you can only set color, count and
angle. Use angle to set the direction of
colors.

Example



Circle gradient
In Circle you can only set the X,Y parameters
for effect.

Example

Clock gradient



Divisions between colors are like clock
needles. All parameters can be changed.

Example:

Rose Line gradient

Example:



As with Clock and Rose Line, all parameters
can be changed

Example:

 QuadGradient
QuadGradient: four colors are chosen
at four points
Setting QuadGradient: as with single
colors, choose color for each point.

Example:



 BumpGradient
Choose a Bitmap Gradient from the System
Templates Library, double-click to apply. Then
set colors.



3.1.2. Texture

Library: choose a template from

the library

Reset: resete parameters

XY Scale: set block size
XY Offset: set block position
Strenght: set texture strength/visibility

3.1.3. Linear Sheen

Colors: set linear sheen colors

Reset: reset parameters

Position: set linear sheen position
Angle: set linear sheen angle
Width: set linear sheen width
Strength: set linear sheen strength/visibility



3.1.4. Bitmap Sheen

Addlight Type

Colors: choose bitmap sheen color

Library: choose a style from the

template library

Reset: reset parameters

Blur: blur bitmat sheen
Strength: set bitmap sheen strength

You can pick between Addlight Type and Mixlight Type

3.1.5. Bump Bitmap

Set Colors, Angle, Height, Strength and
Type (Tile/Stretch)
You can pick a preset template from the
library.
Press Reset to delete set parameters.



3.1.6. Concave

Set Colors, Style
(Raise/Convave/Lightborder), Brightness,
Blur, Angle and Height.
Press Reset to delete set parameters.

3.1.7. Bevel

Set Colors, Size, Depth, Angle and Light
Depth.
Press Reset to delete set parameters.



3.2. Face

In Face you can set the following properties: Color, Texture, Linear Sheen, Bitmap Sheen, Bump
Sheen, Concave and Bevel

Reset: resets all parameters to their

original values.

Delete: deletes Face

Fold/Expand: Folds/Expands all Face

properties

Fold/Expand: Folds/Expands Face,

Edge,Shadow, Depth properties

3.3. Edge

In Edge you can set the following properties: Color, Texture, Linear Sheen, Bitmap Sheen, Bump
Sheen, Convave, Bevel.

As with Face you have Reset, Delete and
Fold/Expand properties.
Unique to Edge:Width and Blur



Edge has different effect types.

3.4. Shadow

In Shadow you can set the following properties: Color, Texture, Linear Sheen and Bitmap Sheen
As with Face you have Reset, Delete and
Fold/Expand properties.
Unique to Shadow: Width, Angle and Blur
properties.



3.5. Depth

In Depth you can set the following properties: Color, Texture, Linear Sheen and Bitmap Sheen.
As with Face you have Reset, Delete and
Fold/Expand properties.
As with Shadow you have Width and Angle
properties.
You can set Shadow type by clicking on the
drop down list.

Example



3.6. Frame

In Frame you can set the following properties: Color, Texture, Linear Sheen and Bitmap Sheen,
Bump Sheen, Convave, Bevel.

As with Face you have Reset, Delete and
Fold/Expand properties.
As with Shadow you have Width and Angle
properties.
Unique to Shadow: Height, Offset and
Space properties.
You can set Frame type by clicking on the
drop down list.

Example



3.7. Advanced properties

You can apply Mask effects by going to the
bottom of the Shader Tab. Here you can
apply a Mask from the template library, set
the blur level and activate/deactivate the
Inverse option.

Setting Mask

1) Enter a text in the Edit Screen, then choose from the Shader Tab.



2) Click on the button to choose a template. Double-click or press to apply.

Set Mask blur parameters
Example

Use Inverse option to inverse effect.



3.8. Editing properties

3.8.1. Combinations

Enter text/object on the Edit Screen, open Shader, and then pick Face, Edge and Shadow. You can
also pick Shader properties first and then input text/object.
By default, when you first enter text only Face is opened. Add other properties.

Click the “Insert” button to add Outline over Face.

Note: you can click the “Insert” button to insert a shader property over the selected property.
The text add a Outline property:



To delete a property, choose the unwanted property and then click on either of the [Delete]
buttons shown in the screen below.
Example
Step 1

Step 2

Move between properties by using the mouse cursor or the [ / ] buttons



Example

Using different properties combinations you can produce all sorts of Title effects. Example:

3.8.2. Preset Styles

You can choose a Preset Style by clicking on the drop-down list shown below.



Below: neon style.

3.9. Shader Template Library

At the bottom of the Shader tab you can open the Templates Library by clicking the

button.



Use the [Add/Delete] buttons to
add/delete templates to/from the library.
Hide the library by clicking on the [Hide
Library] button.

Right-click on a template to see the context menu:
Apply All: applies shader and format
properties to current text
Apply All Except Font Height
Add
Delete
Rename
Apply Shader Style: applies shader properties
to current text
Locate File in Explorer
Move Prev
Move Next
Import
Export
Refresh
Black Background
Gird Background

To add a template you can:

1. Press the button in the library

2. Choose Add from the options context menu.



To delete a template either:

1. Press the button in the library
2. Choose Delete from the context menu
After creating text in the Edit Screen, the easiest way to apply template properties is to
double-click on the desired template.

To apply Shader properties only, press Ctrl and Double-click on the template. Example



3.10. Render Text

As part of the shader properties, you can choose to Render the text as a whole or letter by letter.
Render All: applies Shading effects to the text as a whole.
Individual Render: applies Shading effects letter by letter.

Set the Render format by clicking on the button in the Text Editing Bar.

Example

3.11. Render Image

Specific properties of render image are shown below.

Note: the options are used when image object has shader style property (Face, Outline,
Shadow).
Example:





Chapter Four Graphics (Still) Editing Mode

4.1. Position, Scale, Rotate

To move an object:
1. In the Edit Screen drag the object to the desired position.
2. Click on an object and use the arrow keys on the keyboard. Press Ctrl to increase speed.
3. Enter co-ordinates in the properties tab.
Step 1:Click on the object in the Edit Screen

Step 2:Enter XY coordinates

Zoom Object:
Method 1:
Drag the markers surrounding the object.
Hold Shift to keep XY scale constant.

Method 2:



Enter XY scale in the Properties tab. Press on
the lock to keep XY scale constant.

Rotate object:
Method 1: On the keyboard, hold Shift, then use the Up/Down arrow keys to rotate 45 degrees.
Use Right/Left arrow keys to rotate 1 degree.
Method 2:
Enter numbers in the Properties tab Rotation
field.

Method 3:
Move the cursor to the marker in the centre
of the object

A circle will appear

Drag the marker around the circle to perform
rotation



4.2. Make Group, Ungroup

Make Group will turn many objects into one. To make a group:
1. Hold Ctrl and choose objects, or press Ctrl+A to choose all objects in Edit Screen.

2. Press Ctrl+G or right-click and choose Make Group from the context menu. You can also press
on [Make Group] in the Edit Menu Bar.

Example

To Ungroup press Ctrl+U, right-click and choose Ungroup, or press [Ungroup] in the Edit Menu
Bar.



Example

4.3. Boolean

Boolean is a special form of grouping and includes: Union, Subtract, Intersect and Xor.
To perform Boolean grouping, choose objects then:

1. Use the keyboard shortcuts (Shift+'+', Shift+'-', Ctrl+'+' or Ctrl+'-')
2. Right-click and choose from the context menu.



Example:
Boolean Union

Boolean Subtract

Boolean Intersect

Boolean Xor



4.4. Object level

When you have several objects in the Edit Screen, you can set level by:
1. Using the keyboard shortcuts: Ctrl+PageUp, Ctrl+PageDown, Ctrl+Home, Ctrl+End
2. Right-click and choose from the context menu.

4.5. Mix Option

There are two Mix options: Mix Normal and Mix Penetrate. Two ways to apply:
1. Use keyboard shortcuts Ctrl+T, Shift+T

2. Right-click then choose from the context menu



Example
Mix Normal

Mix Penetrate applied to text

Mix Penetrate applied to object

3. Choose from the Properties Tab



4.6. Align

To align objects you can:
Press [Align Objects] in the Edit Menu Bar

1. Right-click and choose Align Objects from the context menu



Example
Choose Objects:

Align Right, Top, Bottom all use the same steps.



Align Horizontal, Vertical and Centre



When you have more than three objects, you can align range using the [Align Space] button in
the Edit Menu Bar or right-clicking and choosing from the context menu.



Vertically centre multiple objects



Horizontally centre multiple objects

Centre multiple objects

Multiple objects full-screen



4.7. Smart Borders

Smart Borders help you align objects. The border lines will illuminate whenever an object touches
them.
1. Create an object
2. Drag the object to one of the Smart Borders
3. Border line is activated





Smart Borders along the edges will turn red, whilst the centre lines will turn yellow.
In Roll/Crawl settings lines will appear red.



Chapter Five Applying effects

Object effects have two sources: those preset in 3D Transform, and those that have been added
from effect files.

5.1. 3D Transform

1) The effect's play time and Timeline track duration are always equal.
2) An object's 3D Transform effects include Displacement, Scale, Rotate, Pivot and Transparency.
3) Timeline display

In the picture above we can see Displacement Keyframes
4) Parameters in the Effects Tab:

5.1.1. Displacement

Displacement refers to the position of an object at a specific time in space. Where the object
moves depends on the set route and starting position. Example:



Object starting point and trajectory

5.1.2. Scale

Scale refers to the size of the object at a specific time in space.
Example:

5.1.3. Rotate

Rotate refers to an object's rotation movements at a specific time in space. The object centre is
the centre of rotation. Example:

5.1.4. Pivot

Pivot refers to the size of the object pivot at a specific time in space.



5.1.5. Transparency

Transparency refers to how transparent or opaque and object is at a certain point in time.
Example:

Transparency at 100% and 47%

5.2. Applying 3D Transform

To apply 3D Transform:
1. Click”Effect View” to open Effect Edit Mode

2. Click on the Effect Menu Bar

3. To apply parameters use the Edit Screen or the Effect Tab.



4. If Keyframe animation is needed:
a. Activate Keyframe animation parameters as shown below



b. Move the Timeline Marker to the desired location
c. Click on Keyframe Marker to add keyframe (see below)

d. Use the Effect Tab or the Edit Screen to adjust parameters

5.3. Keyframing

 Add keyframe
After moving the timeline click on the add keyframe button.



 Delete keyframe
Move the timeline onto the keyframe, click on the delete keyframe button.

 Copy keyframe
Right-click and choose "Copy" on selected keyframe(s). You can also use the shortcut Ctrl+C to
copy.

Right-click context men
Cut
Copy
Paste Value
Delete
Reset
Constant
Speed Normal
Speed Up
Speed Down
Ease in out
Custom

Copying keframes to other clips: right-click on the 3D Transform track of another clip to see the
context menuPerform paste



When clicking on a single track all keyframes on that track will be selected, as shown below:

Right-clicking on the rectangle shown above gives the following context menu: (This operation
only affects the current track)

Copy keyframe linked list
Paste keyframe linked list
Reset keyframe lined list
Invert keyframe linked list
Keyframe interval list



5.4. Create Freehand Path

Use feehand path create a Bezier motion path for object to move on. Adjusting the parameters of
the Bezier curve any time to change motion track of the object.

1) Create object in the editing area, press shortcut key F10 to switch to effect editing mode.
Click to select the object in editing area, and then click Create Freehand Path button .

Press and hold the left mouse button to draw a path in the editing area. After drawing a path,
release the mouse button and click right mouse button to escape.

As shown in the following picture, the motion path can be adjusted just the same way as Bezier
curve. For detailed instruction, please refer to relavant sections.

2) After adjusting the path, move the timeline to preview, as shown below.



5.5. Create Bezier Path

Create motion path for object with fast Bezier tool. After it’s done, object will move following the
path. Bezier path can be adjusted freely, thereby changing the motion path quickly.
1) Create object in the editing area, press shortcut key F10 to switch to effect editing mode.

Click to select the object in editing area, and then click on Create Bezier Path button .

2) Click left mouse key in the editing area, create a Bezier curve node, then move the cursor and
click a few more times to create a Bezier curve. Drag your mouse horizontally and vertically
allows creating Bezier curve with different radian and angels.

Right click to finish creating Bezier curve, as shown below.



3) Drag the nodes to change the position of the curve. And adjust curve radian with the handle
at the nodes. For detailed information about Bezier curve, please refer to relavant chapters.
Move the timeline to preview the animation.

5.6. Create Ellipse Path

Create oval motion path for object with Ellipse tool. After it’s done, object will move following
the ellipse path. Ellipse Bezier path can be adjusted freely, thereby changing the motion path
quickly.

1) Create object in editing area, press shortcut key F10 to switch to effect editing mode. Click to
select the object in editing area, and then click on Ellipse button.

2) Press left mouse button in the editing area and drag. Release the mouse, and the point will
appear as shown below when you move the mouse. Move the cursor to right position, and
then right click to create an oval path. The movement starting point is shown in the following
picture.



Press CTRL and drag left mouse button to create an ellipse path.

3) Drag the nodes to change the position of the curve. And adjust curve radian with the handle
at the nodes. For detailed information about Bezier curve, please refer to relavant chapters.
Move the timeline to preview the animation.

5.7. Effect composition

There are many template effects that can be added to an object preset effects, including: 2D Pan,
2D Stretch, Linear Dither, Region Dither, Shine, Star Glow, Lens Flare, Stripe, Sparkle, Linear Light,
Radical Light, Image Light, Lens, Wormhole, Swirl, Riple, Circle Lens, Page Curl, Page Turn, Gaus
Blur, Radical Blur, Motion Blur, Box Blur, Spin Blur, Wipe, Mosaic, Flick.



1) The duration of added effects can be freely modified
2) All keyframe effect parameters can be edited
Track example

Effect Tab example

5.8. Effect Templates Library

The software supplies many preset templates for every effect. Double-click on a template to
apply it to the object. Exampe:

Before applying the template you can set other parameters such as duration and appearance.



[In] Button - set when an effect should appear
[Stay] Button - set how long an effect should appear
[Out] Button - set when an effect should disappear
Effect Template Library operation buttons: Add Effect, Delete all effects, Refresh library, Show
Text List

Click on a category to see the full list of effects

5.9. Text effect

Text is the most commonly seen title format on television. VisTitle adds a new scope to how text
can be played, including Whole Text, Line by Line, Letter by Letter, enter progressively exit
instantly, and much more. The user can add play areas and styles according to need.

5.9.1. Setting play area

Right-click on the text bar in the Timeline (shown before) to see the context menu:



Enable/Disable
Add area in Timeline
Delete area in Timline
Text enters letter by letter
Text exits letter by letter
Text enters line by line
Text exits line by line
Whole text instantly visible
Sets play frequency
Sets uniform play areas
Resets play area

Text will be play according to set style and effects.

In the picture above you can see three play areas, each with its own style:

The first play area is set to play by letter, 0.2 frequency, with effects shown in the red field.

The second play area is set to play whole text, with effects in the red field.

The third play area is set to play by letter, 0.2 frequency, with effects in the red field.
Example
Curl in by letter

Flash whole text

Fade out by letter



5.9.2. Play Frequency and Duration

Frequency (q) must be between -1.0 and 1.0, used to determine letter/line in time, play time etc.
1) Frequency only has effect when play by letter/line is set.
2) Frequency can be set in three ways:
i) Right-click, set frequency from context menu

ii) Click on the button shown below, choose frequency from drop-down list

iii) Double-click on frequency field, enter number.



After setting frequency, In/Out points and time will be set automatically using this method:
Play time = T, N. of Items = n, other effect time = t, item = i, then:
Play item In/Out intervals = t*q
Play item In/Out = i*t*q
Play item effect = T/((n-1)*q+1)
Example: five items in 100 frames
a. At frequency 1.0 every effect execution time will be 100/((5-1)*1.0+1)=20 frames, intervals at

20*1.0=20 frames, as in the example to the right.

b. At frequency 0.2, every effect execution time will be 100/((5-1)*0.2+1=55 frames, intervals at
55*0.2=11 frames, as in the example to the right.

Frequency +/- determines play order. Example:
Timeline of every item at frequency 0.2

Timeline of every item at frequency -0.2

5.9.3. Play Whole Text

If set to play as whole text, the entire object will appear instantly.

5.9.4. Play In/Out by Letter

In play in/out by letter, every letter will appear according to frequency and effect settings



Scale In By Letter, frequency 0.1

Fade Out By Letter, frequency 0.2

5.9.5. Play In/Out by Line

In play in/out by line, every line will appear according to frequency and effect settings

Scale In By Line, frequency 0.1

Fade Out By Line, frequency 0.2



5.9.6. Random In/Out Text

Random Text is a subtitle with special effects, with text entering/exiting the screen randomly line
by line or word by word. Select as shown below:

The arrows show how to select Random mode.

The same method broadcasts different texts randomly into the region.

Set A to play randomly line by line and set B to play randomly word by word, as shown below:
Play to 1.5 seconds:



Play to 5.0 seconds:

Play to 7.0 seconds:



5.10. Object Group Effect

Object Groups are special types of objects which can be used to edit multiple shapes (movement,
scale, rotation, etc.), and can be played independently with many effects.

5.10.1. Setting Play Area

Object Group play areas are similar to Text play areas. The Object Group will play set effects
within the allotted time in the Timeline. These setting can be changed by right-clicking and using
the context menu.

In the picture above you can see an example of an Object Group, composed of four objects and
two texts.

Right-click on the play area to choose play options
Enable Area
Add area to the current timeline position
Delete area
Play as child (individually)
Play as group
Uniform
Resets Area

Object Group will be played according to set style and effects.
In the example above the Object Group is split in two
Part 1. Set to play as child, each object will use its own effects.
Part 2. Set to play as group, all objects will be played using group effects (in this case Curl
effects)
Example: Text moving in from the left, object moving in from the right (play as child)
Frame 10



Frame 14

Play as child finish

Example: both text and object play out using Curl effect (play as group)
Frame 30

Frame 40

5.10.2. Play as Group

If set to Play as Group, effects will be played equally to all objects.

5.10.3. Play as Child

If set to Play as Child, objects will play their own effects and group effects will be ignored.



5.11. Setting Stay Area

5.11.1. Setting Stay Area for Title

If you want to change duration of dynamic title, when setting stay areas, animation effect will not
be changed.
Add/Delete Stay Area
Right click on the space above timeline, and choose “Set Stay Area In” to add a stay area in. You
can add a stay area out using the same way.

Note: choose options from the context menu to clear stay area, scale stay area and so on.
Drag in point and out point to change the stay area duration.

Sacle Stay Area
Method 1: right click the stay area and select “Scale Stay Area” from the context menu.

Type in desired timecodes in the popup Scale Stay Area window and then press Enter.



Method 2: hold Ctrl and drag out point to scale.

Example:

Object duration changes, when scaling the stay area, but animation effect does not change.

5.11.2. Setting Stay Area for Subtitle

When setting stay areas, subtitle will automatically scale stay area to make sure the same in/out
effect.
Set Stay Area for Subtitle
Use the operation flow above to set stay area.
Save the subtitle (as shown below) in the template library.

In EDIUS create subtitle using the template (Please refer to the instructions relevant sections of
user manual) to see the subtitle timecodes as shown below.



The time marked by the red double arrow is in/out screen effect duration and marked by the
green double arrow is stay area of effect.



Chapter Six Create Roll/Crawl

The roll screen is often seen at the end of a movie (in the form of credits). In VisTitle you will find
many powerful roll functions, including 3D roll and Mask roll screens.

6.1. Operation flow

Most rolls are aligned, and with VisTitle this can be done quickly and conveniently.
1) In EDIUS, open VisTitle. (Start VisTitle in NLE systems: There is slight difference in how to

start VisTitle in different NLE systems. Please refer to VisTitle Quick Guide for instructions.)
2) In the Menu choose scroll, set roll type (up, right, left), and VisTitle will automatically change

the current layout into a roll screen.

3) Import preset roll screen text onto the Edit Screen.



Set Headings: to set multiple headings, hold
Ctrl, choose headings then press

on.
Heading will turn red. All text under a heading
will automatically become its content.

4) Press Ctrl+A to select all text, then press button. The text will appear in the Edit

Screen.Use Vertically Center-Aligned and Align to the Screen`s Horizontal Center to centre in
toolbar. Example:

Apply “Vertically Center-Aligned” and “Align to the Screen`s Horizontal Center to center” in the
toolbar.



5) Set line intervals using parameters in the image below, then click on .

Example:

6) Press to choose all headings, then apply Shader using the Shader Tab.

Example:



The same method can be applied to Contents.
7) Open the Roll/Crawl Tab to set roll parameters.

Here you can set In/Out format, position and time of the tail, total time, background color, and
area.
8) Save to Template Library when done, and use in EDIUS.
9) In the EDIUS Timeline, double-click on a roll title to edit text or set roll play time.



6.2. Create 3D roll/crawl

1) Use the operation flow above to create a roll/crawl screen.
2) Press F10 to activate Effect Edit Mode, and activate 3D Transform in the Effect Tab.
3) Click on the Timeline 3D Transform track, and use 3D rotate modulator tools to set roll screen

rotation angle.



6.3. Other parameters

6.3.1. Fade In/Out

6.3.2. Scroll Area



6.3.3. Speed down



Chapter Seven Dynamic Texture

When using Shader, other than normal Face, Edge and Shadow bitmap you can also use Dynamic
Texure properties. When played, the object will display dynamic change effects. More than 100
preset templates are available.
Examples:

7.1. Applying Dynamic Texture

1) Create an object or text.
2) In the Shader Tab area, activate Dynamic Texture and set Strength level (0-100). At 0 Dynamic

Texture is not applied, at 100 it completely replaces the current object Shader.

3) Right-click the Dynamic Texture track in the Timeline and a context menu will appear.



Modify file
Adjust duration automatically
Add a dynamic texture file
Insert file in current position
Cut
Copy
Paste
Mask
Delete file
Set file play speed
Delete all files
Select all files

4) Choose Add, then select from the Dynamic Texture Library. You can make further
modifications in this screen, including color and play speed. To apply, double-click on the
template or select first and then click on OK.

5) A bar will appear on the track



6) Set the file In/Out points to mirror object In/Out points.
7) Example.

7.2. Rendreing

1) At any point in time, an object's dynamic texture is unique and can't have more than one.
The dynamic texture will automatically choose the first Shader property (be it Face, Edge or
Shadow).

2) For each layout there can only be one Dynamic Texture track, so all objects will make use of
this file.

3) When rendering in real time, if the Dynamic Texture effects cannot be found, the object will
apply the first Shader property (for example Face or Edge).

7.3. Examples

Dynamic Texture background 1

Dynamic Texture background 2

Text Face using Dynamic Texture



Text and Rectangle Face jointly using Dynamic Texture effects



Chapter Eight Applying Settings

Activate system settings
1) Press shortkey Ctrl+Shift+O
2) Click on [System Option] button at bottom right-hand corner

8.1. Project File Setting

Automatically Save Project: whether save project automatically
Save every step operation: save every step operation in project
Automatically save every *** minutes: automatically save project every the specified time
Max Directory Capacity: set max capacity of auto save path



8.2. Default Setting

Default Fade In/Out Percent - applies default Fade In/Out settings for effects in the 3D Transform
timeline track

Default Object Length - set default object play duration in the timeline



8.3. User Interface

Edit Screen Dynamic Zooming - double-click to adjust screen zoom
Edit Screen Prompt Message - prompt messages such as "Save File" or "Apply Effect"

Timeline Window Dynamic Zooming - double-click on the timeline to adjust window zoom
Auto Load Recent Text File - automatically load last used file at start up
Font Combo Box Standard Style - set font Standard list or Use Current Font list



Default Imput String - press F2 and preset text will appear in Edit Screen

8.4. Text Setting

Set default input string.
Special Language Hotkey Process: switchs font setting with current font setting



8.5. File Path Settings

Project Path: sets project path
Text Path: sets text path

8.6. Background Setting

You can set Edit Screen's background as Solid, Grid, Image and save as a background template



8.6.1. Solid Color

Sets one color as Edit Screen background.

8.6.2. Grid Color

Sets two colors as Edit Screen background.

8.6.3. Image Background

Sets a picture file as Edit Screen background.

8.6.4. Background Template

To save as Background Template
1) Choose a background style.
2) Choose color or picture file.
3) Click on the [Options] button, from drop-down list choose:

Add: adds background as template
Import: import a background
Delete: deletes background template
Delete All: deletes all templates



8.7. 3D View Edit Settings

X Grid Interval：Setting grid intervalin X direction
Z Grid Interval：Setting grid interval in Z direction
Axis Line Thickness：Setting the value of the axis thickness parameter
X Axis Line Color：Setting the X-axis line color
Z Axis Line Color：Setting the Z-axis line color
Grid Line Color：Setting the grid line color
Enable/Disable Live Update Settings



8.8. Keyboard Shortcut

There are four major keyboard shortcut groups that apply to different areas: Global, Layout,
Timeline and Edit Screen.
Note: keyboard shortcuts may be edited in future editions of this software

8.9. Language Setting

To change the VisTitle display language, you can select one language and click the OK button.
The right button are used to import language and delete selected language.



Note: if you want to import other display language, please connect with local dealer.
Note: to apply the language setting, you need to restart VisTitle.



Chapter Nine Layout Export

In practice, the layouts often need to be exported as certain formats, such as PNG sequence,
animation, etc. Our software provides the following formats for the user to choose.
Click Export in Edit View (or Effect View) to select the output format, as shown in the figure
below.
Click Export button in the Edit (or Effect) View to select the output format.
Note: In Edit View, "Output Current Animation Frame Picture" is disabled. This function is
available in Effect View.

9.1. Export Current Layout as Picture

Method 1: press Ctrl+I or click on “File” in menu bar and “Export Layout” in tool bar, then select
“Export Current Layout as Picture” from the drop-down list.



Method 2: Click Export button in the editing area and select "Layout Full Screen Picture..."

Then the Save as window will appear.

In the Save as window set path, enter file name and select file save type then click the “Save”
button.

9.2. Export Current Frame as Picture

Click the Export button in effects editing area and select "Current Animation Frame Picture..."



In the Save as window set path, enter file name and select file save type then click the “Save”
button.

9.3. Export Current Layout as Movie

Press Ctrl+E or select "Export-Movie" in editing area.



Setting properties:
Field Order: select option from the drop-down list.

Clip: set parameters of Top, Bottom, Left and Right after enabling “Clip”.

Set parameters by:
1. Clicking on the field and typing in the numbers
2. Dragging the cursor over the field
3. Moving cursor over the field then clicking on “<, >“
Resolution: set parameters of Width and Height.

You can also click the marked button shown above then select option from the drop-down list.

Codec: click on the dropdownbutton and then select option from the drop-down list.

File Path: click the “Browse” button, the Save as window will appear.



Select path, enter file name then click on the “Save” button in the Save as window.

Render and Preview: click the “Render” button to render. After rendering, click on the “Preview”
button to preview the movie file.

The left button is “Render” and the right is “Preview”.
Preview:

9.4. Export Current Layout as Image Sequence

Click on “File” in menu bar and “Export Layout” in tool bar, then select “Export Current Layout as
Image Sequence” from the drop-down list. The Export Movie window will appear.



Click on the marked dropdownbutton shown above and then select option from the drop-down
list.

Please refer to Export Current Layout as Movie about operation.

9.5. Export Current Layout as QuickTime Movie

Click on “File” in menu bar and “Export Layout” in tool bar, then select “Export Current Layout as
Quicktime Movie” from the drop-down list. The Export Movie window will appear.



Click on the marked dropdownbutton shown above and then select option from the drop-down
list.

Please refer to Export Current Layout as Movie about operation.

9.6. Export Layout to AVI Animation

Click Export button under the File menu, select "Export current layout to AVI animation" from the
drop-down list. The animation export window is as shown below:



Click Settings button on the right side of Codec option, the following window pops up.

For specific setting methods of export layout to AVI animation, please refer to "Export Current
Layout to Animation" chapter.

9.7. Export Project include reference files

Export the current layout and reference files contained in the layout, such as pictures, animation
files, and etc.
Click on “File” in menu bar, then select “Export Project include reference files” from the
drop-down list. The Save as window will appear.
Note: This function requires starting VisTitle software from desktop as standalone. It’s not
available in VisTitle which is opened from EDIUS.



In the Save as window set path, enter file name and select file save type then click the “Save”
button to see the following dialog.

Click the “OK” button, you can open the path and the following will appear.



Chapter Ten Examples

10.1. Create Title

10.1.1. Text

1) Enter the text "Heading" font size 32, and "SubHeading" font size 29.

Method 1: Press button, click on the Edit Screen, then enter text.

Method 2: in the Text properties tab, click on button



Method 3: in the Text properties tab, click button

Open saved file



After text appears in the tab, click on button

Method 4: use System paste
Copy text from desired location



In Object Menu Bar click [Text] button, right-click and paste, or type Ctrl+Shift+V to paste.

2) Color
Method 1: edit color in the Shader tab
Select "HEADING", click Shader tab, set Gradient as Linear, 90 degrees angle.

Add a Gradient point, choose RGB style, and set gradient points to (255, 215, 0, 255), (255, 128, 0,
255), (130, 0, 0, 255)



Choose "SubHeading", enter Shader tab, set RGBA to (232, 232, 232, 255)

Click on , add Edge, set width to 2, set blur to 0, RGB style, RGBA to (0, 0, 0, 255)



Add Shadow, set width to 5, angle to 45, blur to 3, RGB style, RGBA to (0, 0, 0, 128)

Method 2: Double-click on the text and select shader from library.



Method 3: Open Shader Template Library, open Single Color catalogue, choose shader 020.



10.1.2. Liner

1) Create liner
Create a rectangle on the Edit Screen

2) Set shader

Select object, in tab choose Gradient-Linear, angle 90, add a Gradient Point, RGB

style, RGBA parameters at (255,215,0,255), (255,128, 0,255), (130,0,0, 255)

Use the same method to create another rectangle



3) Set text and object level
As the text was created before the object, the object will cover the text.
Method 1: Select text, in Edit Menu Bar choose Move to Top, or type Ctrl+Home.

Method 2: in the Edit Screen right-click text, from context menu choose Move to Top

Method 3: drag text to desired level using the cursor.



10.1.3. Make Group

Method 1: select all objects in Edit Scree, type Ctrl+G
Method 2: Select all objects, right-click then choose Make Group from context menu

10.1.4. Fade In/Out Animation

1) Click [Effect View] to activate 3D editor.

2) Click to open Effect tab, activate Transparency Keyframe, set transparency to 0,

open group in Timeline.



Double-click expand 3DTransform track and choose "Transparency".



3) Move Timeline marker to 1 second,set Transparency to 100.

4) Move Timeline marker to 3 seconds, then click Add/Delet Keyframe .



5) Move Timeline marker to Choice End .

Set Transparency value to 0.



6) Press button to see Fade In/Out effects.

10.1.5. Preview



10.2. Create Effect Title

10.2.1. Text

1) Enter Text

Click , enter "HEADING" font size 20, and "Subheading"font size 37.



2) Shader
In Shader tab set to RGB style, RGBA parameters at (230,230,230,255)

10.2.2. Liner

1) Create liner and shader
1. Green Rectangle: in Edit Screen create rectangle, open Shader tab, set to RGB, RGBA

parameters to (23,87,91,255)



2. Orange Rectangle: create rectangle, open Shader tab, set to RGB, RGBA parameters to
(255,123,0,255)

3. Red Gradient Rectangle: copy-paste orange rectangle, extend length, open shader tab, set
Gradient to Linear, add a Gradient Point, set to RGB, RGBA parameters to (41,0, 0,
255),(160,22,1,255) (85,0,0,255)



4. Adjust objects' poition and size

2) Adjust text-object levels so all text is placed on top of the objects.



10.2.3. Make Group

1) Select both texts using the Ctrl key, right-click and choose "Make Group" from context menu.

2) Use same method to Group all rectangles.The Timeline now has two groups.

3) Double-click to edit group names

4) Set names as "Liner" and "Text Group"



10.2.4. Create Effect Animation

1) Add Effect

Click on object group, open Effect tab, choose 2D Pan, then click on

2) Set Keyframe
1. Set 2D Pan direction as Left to Right

2. Activate effect in Timeline . Set percent to 0 at In point



3. Set percent to 100 at 1 second

4. Set text group animation 2D Pan, Right to Left



5. Activate animation, in Effect tab set percentage to 0 at In point

6. Set percentage to 100 at 1 second



7. In the Edit Screen choose both groups, right-click and choose Make Group from context
menu

8. Hold Shift, drag Group End to 5 seconds on the Timeline

9. Set Timeline marker at 4 seconds, right-click on the track shown below, from context menu
choose "Add Area"

10. Right-click on the track shown, then choose "Play as Child"

11. Add 2D Stretch effect, from Left to Right.



12. Adjust effect position and duration

13. At 4 seconds set percentage to 100



14. At 5 seconds set percentage to 0

10.2.5. Preview



10.3. Create Button



10.3.1. Draw Circle

1) Create a circle by holding Ctrl.

2) Set Shader: Gradient to Linear, 90 degrees, add Gradient Point, RGB, RGBA parameters to
(218,83,20,255),(243,181,100,255),(224,182,74,255)



3) Add Edge: Width 20, Gradient to Linear, 90 degrees, both Gradient Point RGBA parameters
set to (255,255,255,255),(55,54,54,255)



10.3.2. Draw Reflection

1) Using the Object Menu Bar, create a large oval-shaped circle

2) Set Shader: Gradient to Linear, 90 degrees, both Gradient Point RGBA parameters to
(255,255,255,205),(255,255,255,0)



3) Using the Object Menu Bar, create a small oval-shaped circle

4) Set Shader: Gradient to Linear, 90 degrees, both Gradient Point RGBA parameters to
(255,255,155,182),(255,255,255,19)



10.4. Create Custom Shape

10.4.1. Draw Leaf

Use the Bezier Curve tools to draw the following lines





10.4.2. Draw Apple





10.4.3. Shader

1) Make Group

2) Set Shader: Gradient to Linear, 90 degrees, RGB, both Gradient Point RGBA parameters set
to (96,201,21,255),(0,23,0,255)



3) Set Concave effect: Raise mode, Brightness 100, Blur level 2, 45 degree angle, Height 4.



10.5. Create Play by Character



10.5.1. Enter Text and Shader

1) Using the Object Menu Bar [Text] button, enter "VisTitle", font size 64, and press "C" to
centre.

2) Shader: from the shader template library double-click on style 039



10.5.2. Add Area

1) Expand text track, drag timeline marker to 1 second, right-click on the Text track, choose
Add Area. In first area, right-click and choose Play by Character (In).

2) Drag timeline marker to 3 seconds, right-click Add Area. In last area right-click and choose
Play by Character (Out)



3) Set play area Frequency: press to set 0.2 In/Out frequency values.

10.5.3. Set Keyframe in 3D Transform

1) Drag timeline marker to start position, open Effect tab, set Translate XYZ positions to 64, -74,
0.



2) Place timeline marker at Play by Character (In) Out-Point, set Translate to 0, 0, 0



3) Set timeline marker at Play by Character (Out) In-Point, click Add Keyframe

4) Set timeline marker at Play by Character (Out) Out-Point, set Translate to -64, 74, 0



10.5.4. Preview





10.6. Create Play by Line

10.6.1. Enter Text and Shader

1) Write "VisTitle" three times on three different lines, size 40, press "C" to centre.

2) Shader: apply shader 020 from the templates library



10.6.2. Add area

1) Extend duration to 6 seconds

2) Expand tracks, drag timeline marker to 2 seconds, right-click to Add Area, right-click again to



set as Play by Line (In)

3) Set timeline marker at 4 seconds, right-click to Add Area, right-click again to set as Play by
Line (Out)



4) Set play area Frequency: press to set 0.5 In/Out frequency values Set 0.5 frequency

Set 0.5 frequency

10.6.3. Set Keyframe in 3D Transform

1) Drag timeline marker to start position, open Effect tab, set translate XYZ positions to 0, -80,
0



2) Place timeline marker at Play by Line (In) Out-Point, set Translate to 0, 0, 0



3) Set timeline marker at Play by Line (Out) In-Point, click Add Keyframe

4) Set timeline marker at Play by Line (Out) Out-Point, set Translate to 0, 80, 0





10.6.4. Preview



10.7. Create Mixed Play by Character/Line

10.7.1. Enter Text and Shader

1) Using the Object Menu Bar [Text] button, enter "VisTitle", font size 48, and press "C" to
centre

2) Shader: apply shader A036 from the templates library



10.7.2. Add area

1) Extend duration to 6 seconds

2) From 0 to 2 seconds, add Play by Character area, frequency value 0.5



3) From 4 to 6 seconds, add Play by Line area, frequency value 0.5

10.7.3. Set Keyframe in 3D Transform

1) Open Effect tab, at 0 seconds toggle XY scale keyframe to 100 each.

2) At 1 second set XY scale keyframe to 200 each.



3) At 2 seconds, frame 10, set XY scale at 100 each



4) At 4 seconds, frame 20, set XY scale to current keyframe

5) At 5 seconds, frame 10, set XY scale to 200 each



6) At 6 seconds, set XY scale to 0 each



10.7.4. Preview

10.8. Create Advanced Animation Keyframe

Raindrops Animation



10.8.1. Create Cloud

1) Use Object Menu Bar to create circles and a round rectangle

2) Choose “Boolean Union”



3) Set Shader: Gradient to Linear, RGB, RGBA parameters at
(210,210,210,255),(152,152,152,255), 90 degrees.

Add Edge, set to Outer Edge, Width 3, RGB, RGBA parameters at (230,230,230,255).



4) Use Bezier Curves to add cloud reflection. Set reflection: Single color, RGB, RGBA

parameters at (210,210,210,120)



10.8.2. Create Raindrop

1) Use Bezier Curve to draw raindrop



2) Set Shader: Gradient to Linear, 90 degrees, XY axis to (62, 89), RGB, RGBA parameters at
(110,181,227,255),(12,105,175,255).

Add Edge, set to Outer Edge, Width 3, Blur 0, RGBA parameters at (220,220,220,255)



10.8.3. Set Raindrop Animation Keyframe

1) Reduce raindrop play time, from 4 seconds to 1 second

2) At 0 seconds, activate 3D Transfrom Translate (0,5,0), XY scale (0,0), and Transparency (100)
keyframes.



3) Drag timeline marker to frame 15, then set Translate (0,0,0), XY scale (100,100), and
Transparency (add current) keyframes.

4) Drag timeline marker to 1 second, set Transparency to 0



5) Make three more copies to create rainfall effect

10.8.4. Preview





10.9. Create Progress Bar

10.9.1. Liner

10.9.2. Color

1) Select the progress bar high-light, select gradient, 90 degrees, with the RGBA values at
(188,188,188,200), (255,255,255,0).



2) Select the progress bar, select gradient, set RGBA values at (125,34,0,255),
(208,181,172,255), and adjust gradient position to 17.

10.9.3. Merge progress bar and high-light

1) Click on create group, then name group



2) Create Animation: select the group, choose template Wipe001. Click to add special effects
such as equal length, feather level 2.

Select this template, then click on,



10.9.4. Percentage Animation

1) Select the numbers tool, set size to17, RGBA to (232,232,232,255)

2) Set digital animation: Check the key frame interpolation, start value 0, end value 100, the
display format to percentages.

10.9.5. Preview Animation



10.10. Create Roll Up

Please consult the chapter "Create Roll" for instructions.

10.11. Create Crawl

10.11.1. Crawl Left

10.11.2. Create Text

Enter text in Text tab

Click on [One Line Text] to create in Edit Screen



10.11.3. Set Parameters

1) Use the ruler (Tab key) to set roll area

2) Set background area

3) Example



10.12. Render Image

1. Create Image

In the Object menu bar press the button .

Drag cursor then release.

Select image file in Property tab.



2. Set Parameters
Check “Use Shaderstyle to Render” and use “Bright Channel” as Alpha channel. Enable “Always
Use Iamge Color as Face Color” and “Binarization” and set Threshold value.

3. Add Face, Outline, Shadow
Add Outline



Click the “Add” button to add an outline in Shader tab.

Set color and width, Blur value as 4, 0.

Example:

Add Depth



Click the “Add” button to add a depth.

Select Gradient and set width, angle as 24, 59.

Example:

Add Shadow



Click the “Add” button to add a shadow.

Set width, angle and Blur value as 0, 45 and 8.

Example:



4. Preview

10.13. Using 3ds max animation in VisTitle

10.13.1. Set Frame Rate and Time

1) Click [Time Configuration]



2) In "Frame Rate" select PAL, and in "Animation" enter End Time (25 frames equals 1
second).Click on OK.

10.13.2. Render Setting

1) Click [Render setup]



2) Open Common tab, set Range, Output Size, and activate Render to Fields.

10.13.3. Save Setting

1) In the Render Scene diaolge window, click Files under Render Output.



2) In Save As, enter Render Output File name, save as png Image File. (Here, .tga files are used,
but .jpg, .png files can also be used).

10.13.4. Render Animation

In the Render dialoge window, click on [Render] button.



10.13.5. Change Format

1) Open MV program, click , then select 3ds max Render Output File.

2) Type Ctrl+A to select all, then click [Open].



3) Set save location



4) Click [Render] button

10.13.6. Using in VisTitle

1) Open VisTitle, in the Object Menu Bar click . A frame will appear in the Edit Screen



2) In the Properties Tab, click and open the MV Render Output File.



10.14. After Effect Animation in VisTitle

10.14.1. New Composition and Composition Setting

1) Open After Effects, then choose Composition, New Composition

2) In Composition Settings dialogue window, choose size from Preset drop-down list or set
custom size in Height/Width fields. Set project Duration, then click on OK.

10.14.2. Render Area

Drag timeline to set render area



10.14.3. Render Setting

1) In Menu Bar choose Composition, Make Movie.

2) Output Module Settings: in Render Queue tab click [Lossless], then choose PNG Sequence
from Format drop-down list.



3) Set Alpha, choose RGB+Alpha to output sequence is transparent. Click on OK.

4) Name file: click [comp1[####].tga] button, set save location and enter file name. Click on
Save.



5) Click on [Render] to start rendering.

10.14.4. Change Format

Open MV program, import .tga file created in After Effects



10.14.5. Using in VisTitle

Open VisTitle, click , a frame will appear on the Edit Screen. In Properties Tab open MV

render output file.



10.15. Combine Animation with Animated Header

10.15.1. Set Keyframe positions

1) In the Animation Template Library, choose Movie2, "Effects1". Double-click to place in Edit
Screen.
Activate the 3D Edit Mode, and set Effect1 Y-axis to 180 (this animation is a flame that
moves from left to right, but here we invert the direction)



2) From the Animation Template Library, choose Movie1, "Redearth". Adjust size and position.

3) Set Redearth keyframes: extend duration to 7 seconds 9 frames, then drag timeline marker
to 0 seconds. In 3D Transform set animation displacement keyframes.
0 seconds: XYZ (95,0,0), 15 frames: XYZ (0,0,0),6 seconds: XYZ (0,0,0),End point: XYZ (95,0,0),

10.15.2. Background and Text

1) Use Bezier Curves to draw backgrounds, then insert text.



2) Set upper background color: set to gradient, 99 degree, RGBA (185,125,12,255) and
(152,19,0,255); concave effect RGBA (255,255,255,255).

3) Set lower background color: set to gradient, 85 degree, RGBA (218,168,44,255) and
(142,23,6,255); concave effect, RGBA (255,255,255,255).



4) Text color: set "HEADING" RGBA to (210,210,210,255), and "Subheading" RGBA to
(0,0,0,255)

5) Choose "HEADING" and background to Make Group, then set keyframes and duration as
shown below



6) Choose "Subheading" and background to Make Group, then set keyframes and duration as
shown below



10.15.3. Set position

10.15.4. Animation Preview



Chapter Eleven Plugins

11.1. Magic Composite

 Operation Flow of Magic Composite
1. Run Magic Composite Plugin

Choose “Magic Composite” button from the drop-down list of “Title Plugin”.

2. Create Push Back

Click the “Push back object” button , press and drag mouse in the Edit Screen.

Release mouse, create a push back object. New pushback object appears in the object layer list.



3. Adjust Push Layer Counts

First click to select push in Edit Screen, or in the object layer list click to select. Then click the
“Down” button under object layer list to change object layer order.



4. Bezier Editor
First select a push object, click the “Bezier Editor” button or double click left mouse button,
push, and edit Bezier curve.

5. Preview



11.2. Text Kerning/Leading Animation

 Operation Flow of Text Kerning/Leading Animation
Click the “Horizontal Text” button to create a text object in Edit Screen of VisTitle. After creating
object, select “Text Kerning/Leading Animation” from the drop-down list of “Title Plugin” in tool
bar.

11.2.1. Kerning Animation

1. Set Kerning Animation Mode
Click the “Align Center” button in menu bar to set kerning animation mode.

2. Keyframe Setting
Move timeline to 2 second position, click the “Add/remove keyframe” button in the timeline
window.

Change keyfarme parameter to 100 in Property screen.



Move timeline to 4 second position in the timeline window then in Property screen set
parameter as 0.

3. Preview

11.2.2. Leading Animation

1. Set Leading Animation Mode
Click the “Align Middle” button in menu bar to set leading animation mode.



2. Keyframe Setting
Move timeline to 0 second position, click the “Toggle Animation” button in the timeline window.

Move timeline to 2 second position in the timeline window then in Property screen set
parameter as 100.



Move timeline to 4 second position in the timeline window then in Property screen set
parameter as 0.

3. Preview



11.3. Text Path Animation

 Operation Flow of Text Path Animation
1、 Create a curve text in Edit Screen of VisTitle.



2、 After creating, select “Text Path Animation” from the drop-down list of “Title Plugin” in tool
bar.

3、Move timeline to 0 second position, click the “Toggle Animation” button in the timeline
window.

In Property tab set parameter as 100.

4、Move timeline to the tail frame position then click “Add/Remove keyframe” in the timeline
window.

Set parameter as -17 in Property tab.

5、 Preview



11.4. Image Slide Show

 Operation Flow of Image Slide Show
Choose “Image Slide Show” button from the drop-down list of “Title Plugin”.

1. Import Images



Click the marked area in the following picture to import images.

Or click “Import” to import.

After choosing images, click the “Open” button.

2. Set Image Convert Type
Click “Image Convert Type”, select “Pan & Scan” in the context menu.



Set Size
1） Clicking the following buttons can quickly alter size, supported common sizes are full screen,

1/4 and 1/8.

2）Move cursor to the control points, press left mouse button and drag.

3. Adjust Image Order
Left click chosen image, for example DSC02474, in the image list. Then click the “Delete” button
to delete the image.
The buttons on the right side of the list from top to bottom: “Add”, “Delete”, “Empty”, “Up”,



“Down”, “Move to Home” and “Move to End”.

4. Set Special Effect
Choose “Custom” in the Effect Option screen. Click “Effect Class”, select “Others” in the context
menu.

Click “Effect Preset”, select “Random” in the context menu.

Click the “Seed” button behind Random Seed.
Set Picture duration and Effect duration numerical values as 75 and 25.

5. Preview



11.5. 2D Stroke Animation

 Operation Flow of 2D Stroke Animation
Choose “2D Stroke Animation” button from the drop-down list of “Title Plugin”.

1、 Create Stroke Lines
1. Click “PaintStroke” in the tool bar.

2. Left-click in the Edit Screen, drag mouse to create StrokeLine01.

3. Use the same way to create StrokeLine02 and StrokeLine03.



2、 Edit Bezier
Left-click to select a stroke line in the Edit Screen, then double-click, or click “Bezier” in tool
bar.

Drag control points to adjust.

3、 Set Properties



Set Start Position and End Position
Left click to select a stroke line (for example StrokeLine 01) in the Stroke Lines List panel.
Set Start Position, End Position and Stay Time Ratio numberical value as 0, 100 and 0.

Use the same way to set properties parameters for StrokeLine 02 and StrokeLine 03.
Shader
Click the Color button behind Solid Color.

Select color in the Color Select window then click the “OK” button.



Note: this operation will change color of all stroke lines.
Set Thickness, Fineness, Feather and Opacity value as 15, 1, 50 and 100.

4、 Logo

1. Click on the “Logo” button to open Logo tab. Enable “Insert Tracing Logo”.



2. Click the “Browse” button then select a logo, click the “Open” button.

3. Left click and drag the hot point to set logo hot point position.



4. Set X Scale value, Y Scale value and Rotate value as 70, 70 and 0.

5、 Preview



11.6. Image Four-point Deformation

 Operation Flow of Image Four-point Deformation
Create an image object in Edit Screen, choose “Image Four-point Deformation” button from the
drop-down list of “Object” in tool bar.

1. Click on Point1 in Edit Screen, “Add/Remove Keyframe” button after Point1x in timeline
window, you can apply and add a keyframe at 0 second position.



Add a keyframe at 1 second position，set the keyframe value as 20.

2. Click on Point2 in Edit Screen, move timeline to 1 second position, then click on
“Add/Remove Keyframe” button after Point2x in timeline window, thus, you can apply and
add a keyframe.

Move timeline to 2 second position, then click on “Add/Remove Keyframe” button to add a
keyframe，Set the keyframe value as 120.



3. Click on Point3 in Edit Screen, move timeline to 2 second position, then click on
“Add/Remove Keyframe” button after Point3x in timeline window. Thus, you can apply and
add a keyframe.

Move timeline to 3 second position, then click on “Add/Remove Keyframe” button to add a
keyframe, Set the keyframe value as 20.



4. Click on Point4 in Edit Screen, move timeline to 3 second position, then click on
“Add/Remove Keyframe” button after Point4x in timeline window. Thus, you can apply and
add a keyframe.

Move timeline to 4 second position, then click on “Add/Remove Keyframe” button to add a
keyframe, Set the keyframe value as 120.

5. Preview



11.7. Shadow

 Operation Flow of Shadow
Create an object in Edit Screen, choose “Shadow” button from the drop-down list of “Object” in
tool bar.

11.7.1. Back Shadow

Click on “Back Shadow” button in Property panel.



Click on the Color button, select a color, then press the “OK” button.

 Still Shadow
Step-1 Setting parameters in back shadow properties panel.



Click on “Translation” button in tool bar.

You can also drag control point in editor area to adjust positions in the X and Y axis.

Step-2 Preview

 Dynamic Shadow
Step-1 Adjust timeline to 0 second position, click on the “All Parameters Animating” button.



Set parameters shown below.

Step-2 Move timeline, then click on the “All Parameters Animating” button.

Set parameters shown below.



Move timeline to the tail frame position, click on “All Parameters Animating” button.

Set parameters shown below.

Step-4 Preview



11.7.2. Mirror shadow

Click on the “Mirror Shadow” button in the Property panel.

Still Shadow
Step-1 Setting parameters in mirror shadow properties window.



Click on “Translation” in tool bar.

You can also drag control point in editor area to adjust positions in the X and Y axis.

Step-2 Preview



 Dynamic Shadow
Step-1 Adjust timeline to 0 second position, click on the “All Parameters Animating” button.

Set parameters shown below.



Step-2 Move timeline, then click on the “All Parameters animating” button.

Set parameters shown below.



Step-3 Move timeline, then click on “All Parameters Animating”.

Set parameters shown below.



Step-4 Preview

11.7.3. Slant Shadow

Click on the “Slant Shadow” button in the Property panel.



Click Color button, select a color, then press “OK” button.

 Still Shadow
Step-1 Setting parameters in slant shadow properties window.



Click on “Translation” in tool bar.

You can also drag control point in editor area to adjust positions in the X and Y axis.

Click on “Slant” in tool bar.

You can also drag control point in editor area to adjust slant shadow positions in the X and Y axis.



Step-2 Preview

 Dynamic Shadow
Step-1 Adjust timeline to 0 second position, click on “All Parameters Animating”.

Set parameters shown below.



Step-2 Move timeline, then click on the “All Parameters Animating” button.

Set parameters shown below.



Step-3 Move timeline, then click on “All Parameters Animating”.

Set parameters shown below.



Step-4 Preview

11.8. 2D Vector Transform

 Operation Flow of 2D Vector Transform
1. Create a text object in Edit Screen and select “2D Vector Transform” from the
drop-down list of “Title Plugin” in tool bar.

2. Move timeline to 0 second, and drag the text object to adjust position.



When adjusting object position and pivot position, keyframes will add in Timeline window.

3. Click "Toggle Animation" of Scale X and Scale Y to add keyframes.

4. In the Properties Window set Scale X value and Scale Y value to 0.



5. Click "Go to Next/Tail Keyframe" in Timeline Window or Properties Window.

Move timeline to the tail keyframe then click "Add/Remove Keyframe" to add Scale X
keyframe and Scale Y keyframe.

6. In the Properties Window set Scale X value and Scale Y value to 350.



7. Move timeline to 0 second and click "Toggle Animation" to add Rotation keyframe.

8. Move timeline to the tail keyframe and click "Add/Remove Keyframe" to add Rotation
keyframe.

9. In the Properties Window set Rotation to 360.



10. Preview
At 0 second:

At 1 second:



At 2 second:

At 4 second:



11.9. Karaoke

 Operation Flow of Karaoke
Choose “Karaoke” button from the drop-down list of “Title Plugin”.

1、 Import File
1) Import Text

Method 1: click the “Import Text” button in the File menu.

Method 2: left-click on the text track head in the timeline panel.



Browse and select file then click the “Open” button in the Open window.

2) Import Audio File

Method 1: click the “Import Audio” Knob in the File menu.

Method 2: left-click on the audio track head in the timeline panel.

Browse and select *.mp3 file, *.wav file then click “Open” button.



2、 Set Font Properties
Set font as Arial, Bold and size as 70 in tool bar.

3、 Record Karaoke
Adjust play speed and volume then click the “Record” button.

Press Space as the sign of timein and release as timeout.

4、 Shader
Click Color button behind Front, choose color in the popup Color Select window.



Left click in the Width numerical value frame, input number 4.

Back color setting methods are the same as front color setting.

Click the “Add to Library” button to save the current shader template to library.



5、 Set Animation Properties
Click the “Animate” button to switch to animation property setting panel. Activate “Use
Animation”.In the animation library, double click to choose template.

6、 Basic Property
Click the “Property” button to switch to property setting panel. Click to choose “Dual Line” and
“Top Left” in the drop-down lists of Arrange and Align Style.



Enable “Swap When Dual Line” and set Left, Right, Top and Bottom value as 76, 691, 402 and
517.

7、 Set Mark
Select a text line, right click, select “Set Mark” in the context menu, Mark dialog pops out.



Click on the drop-down menu marked in the picture above, to choose marks such as M, F and T.

8、 Preview

11.10. Handwriting

11.10.1. Brief Introduction

Using handwriting plugin can make general handwriting effect. Stroke radius and stroke speed
will be set different values according to different requirement. You can edit
color property of every stroke. Or applying original alpha to set color.



Create a text or image object, choose one object as handwriting material.

Click on “Object” button in tool bar, then choose “Handwriting” button from the drop-down list
of “Title Plugin”.



11.10.2. Handwriting Interface Description

 Tool Bar

The buttons order from left to right is “Undo”, “Redo”, “Reset”, “Select”, “Fast Draw”, “Paint
Sketch”, “Paint Contour”, “Delete”, “Edit Bezier”, “Edit Radius”, “Auto Head-Tail Arrange Stroke
time”, “Hide Circle”.
 Editor Area
Editor area is used for painting sketch, painting contour and showing handwriting effect.



The buttons order of marked buttons from left to right is “Fit Window”, “Actual Size”, “View
Zoom”, “To select the previous stroke”, “To select the next stroke”, “Play Start”, “Play”, “Current”,
“To Home”, “To end”, “show Alpha Image”, “Show Full Color”, “Show Alpha Only”, “Show Fill
Color”.
Common right button functions of editor area
Right-click on editor area. Following is the context menu.

 Timeline
Timeline screen is used to display strokes and set stroke radius or speed. Timeline window
includes two parts. The right part can show timeline position and stroke playing time length. The
left part displays object tree structure. It is applied to add or remove keyframe.



The common buttons in timeline screen

The buttons order of marked buttons from left to right is “Track Visible/Invisible”, “Expand/
Collapse Track”, “Toggle Animation”, “Go to Prev/Head Keyframe”, “Add/Remove keyframe”, “Go
to Next/Tail Keyframe”, “Lock/Unlock Track”.

The buttons order from left to right is “Timeline Auto Snap”, “Expand all Track”, “Graph View”.
The right marked button is used in scaling time.
General right button functions of timeline window
Click on a stroke in timeline window, then right-click on it. The following is the corresponding
context menu.

Right-click on the blank of timeline window.



 Stroke Properties
Stroke properties screen contains stroke list window and attribute setting panel.

The marked time by arrow is total playing time of all strokes. Clicking on it and inputting number
can scale all strokes play time proportionally.
Stroke list
Stroke list layout shows all strokes in editor screen. It can be used for deleting and inserting
stroke. The buttons order of marked buttons from left to right in the right part of the image is
“Add”, “Insert”, “Delete”, “Up”, “Down”, “Head”, “Bottom”.
Properties
In the part below of the image, the marked screen is properties setting panel to edit stroke color,
radius and speed.

11.10.3. Paint Sketch

Click on “Fast Draw” button in tool bar,



Press and drag mouse to draw a stroke. If you operate “Handwriting” for the first time, you need
not choose “Fast Draw” button.

Note When painting sketch you should draw according to actual writing type. For example,
the type is from left to right.
“Paint Sketch” button can be applied to delete original sketch.

The methods to delete stroke:
Method1: Click on the selected stroke, then click on “Delete” button in tool bar.

Method2: Click on the selected stroke, then click on “DELETE” of keyboard shortcuts.

11.10.4. Paint Contour

Click on “Paint Contour” button, then drag cursor to draw a closed curve around stroke edge of
stroke sketch.



Note Stroke contour should be larger a little than stroke edge

11.10.5. Edit Bezier

When tiny sketch or contour fault need be rectified, you can use Bezier editor.
Click on stroke sketch or contour in editor screen, then double-click on cursor or click on “Edit
Bezier” button in tool bar.

You can refer to guidence of VisTitle to learn editing Bezier approach.

11.10.6. Stroke Radius

Some special font, for example, running-hand of great handwriting master, their radius often
need be adjusted to be perfect.



Open “Handwriting” to paint sketch or contour, then choose stroke to change its radius.
Method1:
Click on current stroke in editor screen, then choose “Edit Radius” button. There will be a circle
on Stroke sketch. Click on the control point and drag it to change stroke radius.

Note Click on “Hide Circle” button you can set circle visibly or invisibly.

Right-click on circle center.



Method 2:
Click on current stroke in editor screen. Move timeline to preview. Add a keyframe to adjust
stroke radius wherever radius need be changed.
Click on “Add/Remove Keyframe” button to add a keyframe in properties or timeline window.

Drag radius slider or input suitable value then click on ENTER.



11.10.7. Stroke Playing Speed

All strokes playing time are equal in the system default condition. Changing stroke playing time
length, stroke playing speed will change. But every stroke is played at constant speed.

Every stroke can be adjusted to show special effect.
Method1: (playing current stroke at constant speed)
Click on selected stroke in timeline window, then drag both ends of the stroke. Along with the
change of stroke playing time length, stroke playing speed will change.



Click on selected stroke in stroke list window. Double-click on in-time and out-time, then type in
values. Thus you can also change the stroke playing time length.

Method2: (playing current stroke at different speed)
Add a keyframe and change keyframe values to adjust stroke playing speed. This action is often
used when several strokes are linked up.

The marked part is drawn fast, so the playing speed need be adjusted.
Click on “Add/Remove Keyframe” in timeline window or properties window to add a keyframe.



Click on the second keyframe and move it to suitable position after add a keyframe. The shorter
playing time between the first keyframe and the second keyframe gets, the faster current stroke
playing speed will get.

Just like when increase time length between two keyframes, playing speed will get slower.

11.10.8. Edit Graph View

 Radius
Choose “Graph View” button in timeline window. Click on radius track.



Move timeline in graph view window, then click on mouse to add a keyframe. The marked time is
playing time length of current stroke.

Press mouse and drag it up and down to adjust selected keyframe values,

Press ALT and mouse, drag selected keyframe left and right,

Right-click selected keyframe,



Right-click in the area where there are not keyframes,

 Speed
Choose “Graph View” button in timeline window. Click on speed track to switch to speed graph
view.
Move timeline in graph view window, then click on mouse to add a keyframe.

Press mouse and drag it up and down to adjust selected keyframe values. Press mouse and drag
controllers to show speed change between two keyframes.



Press ALT and mouse, drag selected keyframe left and right,

Right-click selected keyframe,

Right-click in the area where there are not keyframes,

11.10.9. Stroke Color

 Original Color
Strokes color is original color in the system default condition. Here only feather value can be
changed.



Drag feather slider, input number and click on ENTER to change feather value.

 Solid Color
Click on “Solid Color” button. All strokes color is equal in the system default condition.

Click on color panel behind “Solid Color” button. Choose a color in the left part or move circle to
select a color. The values of RGB can be changed to pick out a color.



If you want to set different stroke color, firstly click on “All Same Color” to make it unable,
secondly choose a stroke, thirdly select a color in color panel.

Click on “Original Alpha” button to apply it. Double-click to close it. Drag feather slider or input
number and click on ENTER to change feather value.

Original Alpha
When activating “Original Alpha”, strokes are drawn according to the original strokes. When

close “Original Alpha”, strokes are drawn according to the contour size.



Following is different effects of applying original alpha and close original alpha.



11.10.10. Playing Time

Stroke playing time length
Choose a stroke in editor window or stroke list window, then drag both ends of the stroke to
change its playing time length.

To change stroke playing time length after selecting a stroke in stroke list window,

Double-click on the marked, type in suitable values.
Total playing time length
Click on the time number above stroke list window, type in value then click on ENTER. The time
number is total playing time length of all strokes. Once it has been changed, every stroke playing
time length is scaled proportionally.

There are some special conditions after changing stroke playing time length, such as strokes



overlap, gap.

Click on “Auto Head-Tail Arrange Stroke Time” button,

Strokes will auto head-tail arrange.

11.10.11. Setting General Functions Preview area

 Edit Ruler or Grid
Followings are some basic functions preview area .
Right-click on mouse, choose the applied option.

 Set View Zoom
Method 1: Right-click in the preview area, choose “View Zoom”,



Method 2: Right-click and drag mouse in the editor screen.
 Set Aidline
To create aidline you can press left key of mouse and drag it in ruler area. If you want to delete
the aidline, you can right-click in the aidline head.

11.10.12. Set Sync Background

Click on “Sync Background” button in the status bar to set.

11.10.13. Operation Flow of Handwriting

Create a text or image object in Edit Screen, then choose “Handwriting” button from the
drop-down list of “Title Plugin”.



Step-1 Paint Stroke Sketch
Click on the “Fast Draw” button in tool bar.

Press and drag mouse to draw a stroke. If you open the Handwriting plugin for the first time, you
need not choose “Fast Draw” button.

Draw all sketches.



Step-2 Paint Contour
Choose a stroke sketch then click on “Paint Contour” in tool bar.

Drag mouse to draw a closed curve around stroke edge of stroke sketch.

Draw all contours.



Step-3 Edit Bezier
Double-click on stroke sketch or contour in Edit Screen.

Drag Bezier point or Bezier controller to edit Bezier.

Step-4 Stroke Color
Click on “Solid Color” button to set same color for all strokes. Set feather value as 100. Click on
Color button behind “Solid Color”.



Choose a color in the color panel, then click on the “OK” button.

You can also click on Color button in stroke list panel to choose a color.

Step-5 Stroke Playing Speed
Change Playing Speed of a Section of Stroke
Move timeline to the position where stroke playing speed need to be changed.



Click on “Add/Remove Keyframe” in timeline window to add a keyframe.

Click on “Add/Remove Keyframe” in the Property tab to add a keyframe. Set keyframe value as
80.

Change Playing Speed of a Stroke
Click on the selected stroke in timeline window, then drag both ends of the stroke.



Step-6 Set Radius
Step-1 Click on “Edit Radius” in tool bar.

Step-2 Move timeline to the position where stroke radius need to be changed. Click on the
“Toggle Animation” button in timeline window.

You can also click on the “Toggle Animation” button in Property tab to add a keyframe.

Step-3 Drag radius slider in the Edit Screen or input suitable Radius value in the Property tab to
change stroke radius.



Set radius value as 120.

Just like you can add several keyframes and edit different strokes radius values.
Step-7 Preview



11.11. 3D Particle

11.11.1. Brief Introduction of 3D Particle

3D Particle plugin is a professional 3D particle tool. Using 3D Particle plugin can make point
particle, line particle and box particle and so on. Creating 3D particle and preview can be acted
on simultaneously. You can set particle life and size and so on. Particle emitter with multiple
particle streams can be created as needed. Plentiful particle templates can be applied directly.

Choose “3D Particle” button from the drop-down list of “Title Plugin”



11.11.2. Interface Description

 Tool Bar

The buttons from left to right are “Undo”, “Redo”, Edit Menu (including “Copy object”, “Paste
Object”, “Cut Object” and “Delete Object”), “Show/Hide View Ruler”, “Show/Hide View Grid”,
“Show/Hide View Safe Area”, “Show/Hide View Crossline” and background option.
File menu includes New, Open, Save and Save as.

 Particle Type
Particle type includes Point Emitter, Line Emitter, Rectangle Emitter and so on. Click the buttons
to choose a certain type.



 Edit Screen

Edit particle in 3D edit show window. The marked buttons from left to right are “To Head of
Selection”, “To End of Selection”, “Play from Start”, “Play”, “Loop”, “To Home”, “To End”.
Left time code is the current play time. You can click it and enter value to set play time. Right time
code is the total play time.
Context Menu
Right click on a particle emitter, the following context menu will appear.



 Timeline Window
Timeline Window is used in setting 3D Transform keyframe, playing time and so on. Timeline
Window includes two parts. The right part can show timeline position and particle playing time
length. The left part displays object tree structure. It is applied to add or remove keyframe.

Buttons in Timeline Window

The marked buttons from top to bottom are “Track Visible/Invisible”, “Expand/ Collapse Track”,
“Toggle Animation”, “Go to Prev/Head Keyframe”, “Add/Remove Keyframe”, “Go to Next/Tail
Keyframe”, “Enable/Disable Track” and “Lock/Unlock Track”.

The buttons from left to right are “Timeline Auto Snap”, “Expand all Track” and “Graph View”. The



right marked button is used in zooming in/out timeline window.
Context Menu
Right-click on an emitter track in the Timeline to see the context menu:

Right-click on empty space in the Timeline to see the context menu:

 Properties Window
The Properties Window has five tabs: 3D Transform, Template Library, Emitter Property, Particle
Property and Particle Parameter.



Template Library
The above marked buttons in the image below from left to right: Template Library List, “Add”,
“Delete” and “Rename”
The below marked buttons from left to right are “Add”, “Delete”, “Apply”, “Import”, “Export”,
“Refresh”, “Switch Display Mode” and Zoom In/Out bar-button in the image below.



Changing template name: double-click on the template name or right-click on the template and
choose "Rename" from the context menu, enter a new name and then click on the “OK” button.

Right-click on empty space in the library to see the context menu:



Set Parameters

Set parameters by:
4. Clicking on the field and typing in the numbers
5. Dragging the cursor over the field
6. Moving cursor over the field then clicking on “<, >”
7. Dragging the slide marked in green in the image above
 Status Bar

The buttons are “Syna background with host program” and “Use low layer image as background”
used to set plugin background.

11.11.3. Create Emitter

Choose a particle type then click or drag mouse in Edit Screen.



 Point Emitter
Click the “Point Emitter” button then click on the Edit Screen.
 Line Emitter
Click the “Line Emitter” button then left click or drag mouse in Edit Screen to create emitter
points. Press ESC or right click to finish creating.

You can Bezier Edit the line.
 Other Emitter
Other Emitter includes Rectangle Emitter, Circle Emitter, Box Emitter and Ball Emitter. Here take
Rectangle Emitter as example.
1. Click the “Rectangle Emitter” button.



2. Press and drag mouse in Edit Screen.

3. After creating a rectangle, release mouse.

Note: holding Ctrl and dragging mouse, you can create a square.
To create Box particle:
1. First, click the “Box Emitter” button.
2. Second, press and drag mouse then release in Edit Screen.



Drag mouse up and down to change box deep.

3. Finally, left click.



11.11.4. Make Super Emitter

Method 1: In Edit Screen right click an emitter, select “Make Super Emitter” from the context
menu or press Shift+S.

Method 2: In Timeline Window right click an emitter track, select “Make Super Emitter” from the
context menu.

11.11.5. 3D Transform

 Set 3D Transform Parameters in Properties Window
Select a particle emitter in Edit Screen then in Properties Window click on the “3D Transform”
button to open the 3D Transform tab. The above buttons from left to right are “All Parameters
Animating”, “Reset Current Keyframe”, “Reset”, “Fold/Expand”, “Delete” and “Save File” in the
image below.



Add/Remove Keyframe

In Timeline Window click on , a keyframe will be added at current play position. You can also
click on to add keyframe at current play position or click the “Add/Remove Keyframe” button
in 3D Transform tab. The left marked buttons are “Toggle Keyframe”, “Go To Pre/Head Keyframe”,
“Add/Remove Keyframe” and “Go To Next/Tail Keyframe” in the image above.

Set Keyframe Parameters
Click on the value and typing in numbers then press ENTER. Please refer to other chapters about
the other methods.
Right-click on a keyframe marker to see the context menu:



 Set 3D Transform Parameters in Edit Screen
Select a particle emitter then click the 3D Transform buttons in Edit Screen.
Translate
In Edit Screen click on the “Translate” button, drag the markers to set XYZ position.

Move timeline onto a keyframe, then in Edit Screen right click other keyframe markers to see the
context menu.

Rotate
In Edit Screen click on the “Rotate” button, drag the markers to set XYZ rotation.



Move timeline onto a keyframe, then in Edit Screen right click other keyframe markers to see the
context menu.

Scale 3D
In Edit Screen click on the “Scale 3D” button, drag the markers to scale along XYZ axis.

Move timeline onto a keyframe, then in Edit Screen right click other keyframe markers to see the
context menu.



Pivot
In Edit Screen click on the “Pivot” button, drag the markers to set pivot XYZ axis position.

Move timeline onto a keyframe, then in Edit Screen right click other keyframe markers to see the
context menu.



11.11.6. Emitter Property

In Edit Screen select an emitter then in Properties Window, click on the “Emitter Property”
button to open the Emitter Property tab. Emitter Property tab consists of Emitter Property screen
and Control screen.

 Emitter Property
Preload Frame: set emitter head keyframe effect as the preload frames effect.
Color Tone: click the “Color Tone” button, the Color Select window will appear.

To set color:
6. Choose one of the 32 preset colors



7. Use the cursor to pick a color from the palette
8. Set parameters in the RGB Alpha fields
9. Use the scroll bar to set alpha

Shape Style: set particle emitter shape style.

Emit Direction: set particle emit direction.
Point Emit: set emitter number in XYZ axis.

For example, Box emitter number in XYZ axis is 2, 3 and 4 as shown below.

 Control Property
Expand the Control track in Timeline Window.
In Timeline Window expand the Control track to see that Control properties include Life, Quantity,
Size and so on.



Add/Remove Keyframe

In Timeline Window click on , a keyframe will be added at current play position. You can also
click on to add keyframe at current play position or click the “Add/Remove Keyframe” button
in 3D Transform tab. The left marked buttons are “Toggle Keyframe”, “Go To Pre/Head Keyframe”,
“Add/Remove Keyframe” and “Go To Next/Tail Keyframe” in the image below.

Set Keyframe Parameters
Click on the value and typing in numbers then press ENTER. Please refer to other chapters about
the other methods.

11.11.7. Particle Property

Click the selected emitter track to enable the Particle Property tab. Particle Property tab consists
of Particle Model screen and Particle Option screen.



 Particle Mode
Particle Image

Flip X: enable “Flip X”, particle image will flip horizontal.
Flip Y: enable “Flip Y”, particle image will flip vertical.
Random Start: enable “Random Start”, particle start frame effect is random frame effect of
particle image animation
Start Frame: set particle start frame effect as a certain frame effect of particle image animation.
Repeat: set particle animation speed. For example, inputting 5, you can see that next frame
animation plays every 5 frame.
MonoColor: set particle image color as monocolor.
Click the left marked space, the Particle Image File Select window will appear. The left part is
particle image basic information and preview. The right part is particle image template library.



You can preview in the left part after click an image in the right part. The above marked is image
size, path and current preview frame/preview frames. The left marked is image pivot position.
You can change and reset the X, Y parameters or drag the marked pivot. The right marked buttons
are “Prev Frame” and “Next Frame”
Particle Color
You can click the left above marked button or check the below marked option to link Color and
Alpha.

In the image above click under the color bar to add a Marker, drag to set position. Set the central
position between colors using the blured block over the color bar. First click on Color Marker,
then set color. To set color:
1. Choose one of the 32 preset colors
2. Use the cursor to pick a color from the palette
3. Set parameters in the RGB Alpha fields



Press Delete to remove Marker, or right click Marker then select “Delete”.

Motion Angle
Choose a motion angle type then input numbers.

 Particle Option
Attach Emitter: after enabling “Attach Emitter”, you can use the scoll bar to set distance between
particle and emitter.
Seed: set random seed number
Use Emitter Angle and Range: enable/disable emitter angle and range

The marked is “Reset” button to reset all Particle Option parameters.

11.11.8. Particle Parameter

Click the selected emitter track to enable the Particle Parameter tab. Particle Parameter tab
consists of Particle screen, Variation screen and Over Life screen.
 Particle
In Timeline Window expand the Particle Stream-Particle track.



Add/Remove Keyframe

In Timeline Window click on , a keyframe will be added at current play position. You can also

click on to add keyframe at current play position or click the “Add/Remove Keyframe” button
in 3D Transform tab. The middle marked buttons are “Toggle Keyframe”, “Go To Pre/Head
Keyframe”, “Add/Remove Keyframe” and “Go To Next/Tail Keyframe” in the image below.

Set Keyframe Parameters
Click on the value and typing in numbers then press ENTER. Please refer to other chapters about
the other methods.
 Variation



In Timeline Window expand the Particle Stream-Variation track.

Variation parameters:

Please refer to other chapters about the methods of setting parameters.
 Over Life
In Timeline Window expand the Particle Stream-Over Life track.

Over Life parameters:



Please refer to other chapters about the methods of setting parameters.

11.11.9. Edit Graph View

Choose “Graph View” button in Timeline Window. Every property graphic view has its own color.

Move timeline in Graph View window, then click to add a keyframe. The marked time by
double-arrow is playing time length.



Click keyframe marker and drag up and down to adjust the value.
Right-click selected keyframe marker to see the context menu:

Right-click the area where there are not keyframe markers to see the context menu:



11.11.10. Set Edit Screen

 Edit Ruler or Grid
Right-click in Edit Screen, choose one option.

 Set View Zoom
Method 1: Right-click then select

Method 2: Right-click and drag cursor in Edit Screen
 Aidline
To create aidline you can left click and drag cursor in ruler area. To delete the aidline, you can
right-click in the aidline head.



11.11.11. How to Preview Particle

In Template Library tab click a particle, you can preview in the Preview Window.



Click the marked “Show/Hide Preview Window” button to show/hide Preview Window.

11.11.12. Set Background

Enable “Sync background with host program” in status bar to set same background with the host
program background.



Enable “Use low layer image as background” in status bar to set low layer image in host program
as background.



11.11.13. Operation Flow of 3D Particle

1. Run 3D Particle Plugin
Choose “3D Particle” button from the drop-down list of “Title Plugin”.

2. Create Particle Emitter
Press the “Point Emitter” button then click on the Edit Screen.



3. Set Emitter Parameters
Set size as 170 in Control screen of Emitter Propertiey tab.

4. In Particle Property tab click the marked field shown below. Then in Particle Image File Select
window select Star004.



Set the four color markers RGB as (255,126,154), (255,137,34), (255,252,165) and (0,0,0).

Set Transparent value as 255 and 0.



Check “Use Emitter Angle and Rangle” in Particle Option screen.

5. Set Particle Parameters
In Particle screen of Particle Parameter tab, set Life value as 150, Quantity value as 65, velocity as
1, Random Motion value as 2 and Transparent value as 88.

In Variation screen, set Life Variation value as 53, Size X Variation value and Size Y Variation value
as 4.

In Over Life Screen, click the “Toggle Animation” button of Size X Over Life. Set the value as 30
then click the “Go To Next/Tail KeyFrame” button and set the value as 180.
Click the “Toggle Animation” button of Size Y Over Life. Set the Head Keyframe value as 30 and
the Tail Keyframe value as 180.
Click the “Toggle Animation” button of Velocity Over Life. Set the Head Keyframe value as 100
and the Tail Keyframe value as 0.



6. Set 3D Transform Parameters
Move timeline to 0 second position, Click on the “Toggle Animation” button of Translate.
In 3D Transform tab set Translate value as (-53, 0, 0).

Move timeline to 1 second position, in 3D Transform tab set Translate parameter shown below.



7. Preview

11.12. 3D Plugin

 Operation Flow of 3D Plugin
Operation of 3D model, 3D text, and 2D Path to 3D plugins are generally the same, which will be
introduced in the same chapter.

11.12.1. Operation Differences of Three Plugins

Operation differences of these three plug-ins are as follows.



 3D Model
Choose “3D Model” button from the drop-down list of “Title Plugin”.

 Set Model Properties
In Model tab, click the “Sphere” or RoundBox button ,set parameters as needed.

 3D Text
1. Create Text Object
Click the “Horizontal Text” button to create a text object in Edit Screen.



2. Run 3D Text Plugin
After creating text, select “3D Text” from the drop-down list of “Title Plugin” in tool bar.

3、Set Font Properties Parameters
In Font Bar choose a font as shown below.



You can set font size through setting text height and width shown below.

Please refer to relevant chapters about methods of setting parameter.
4、Set Model Properties
In content screen you can change text content. Press Enter to line feed and Ctrl+Enter to finish
editing.



 2D Path To 3D
1. Create Object (taking text object as example)
Click the “Horizontal Text” button to create a text object in Edit Screen.

2. Run 2D Path To 3D Plugin
After creating object, select “2D Path To 3D” from the drop-down list of “Title Plugin” in tool bar.

11.12.2. Same Operation of Three Plugins

Other operations of the three plug-ins are basically the same. The material properties, lighting
properties, UV coordinate properties, and three-dimensional transformation properties are
introduced below.



11.12.2.1. Material Property

The material property of object can be set in all the three plug-ins. The following uses "Phong",
"Bump" and "Reflect" material as examples to introduce how to apply the materials.
 Phong Material
1) Set Model Properties
In Model tab, click the “Round Box” button and set width, height and depth as 500 and Bevel
Segment value as 2.

2) Set Material Properties
In Material tab, click the “Add” button to add Phong material.

Add Phong material again.



Link Back Face and Front Face with the first Phong material, Right Face and Left Face with the
second Phong material and Top Face and Bottom Face with the third Phong material.

Select the first Phong material and in Parameters screen click the “Texture-Image” button.



Double click a pattern in the popup Select Pattern Window.

Set other parameters as the default.



Select the second Phong material and in Parameters screen click the “Texture-Image” button.

Double click a pattern in the popup Select Pattern Window.



Set other parameters as the default.

Select the third Phong material and in Parameters screen click the “Texture-Image” button.



Double click a pattern in the popup Select Pattern Window.



Set other parameters as the default.
 Bump Material
1） Set Model Properties
In Model tab, click the “Sphere” button and set radius as 348.

2） Set Material Properties
In Material tab, click the “Add” button to add Bump material.



Link Face with the Bump material to set Face material as Bump and delete the Phong material.

In Parameters screen click the “Texture-Image” button.

Double click a pattern in the popup Select Pattern Window.



Click the “Bump-Image” button.

Double click a pattern in the popup Select Pattern Window.



Set other parameters as the default.
 Reflect Material
1. Set Material Properties
In Material tab add a Reflect material.

Set all faces material type as Reflect.



In Parameters screen click the “Texture” button.

Double click a pattern in the popup Select Pattern Window.

 Template Library



Double-click template or choose “Apply” in right-click menu to in material template library to
apply material properties of the template.

11.12.2.2. Light

Settings of light property in the three plugins are the same. Introduction of light property is as
follows.
In Properties Window click on the “Light” button to open the Light tab. Please refer to other
chapters about setting parameters.
 Light Tab Introduction



Add: add light
Delete: delete light
Ambient Light: set ambient light color.
Template Library: open Template Library
Parameters: open Parameters screen
Type: select light type
Color: set light color
Position X: set light X position
Position Y: set light Y position
Position Z: set light Z position
Longitude dir: set light Longitude direction
Lattitude dir: set light Lattitude direction
Spot Angle: set spot angle
Spot Soft: set spot soft

Set Light Keyframe in Timeline Window

Add/Delete Light

Click the “Add” button and choose a light type to add. Click on the light in light list and click

the “Delete” button to delete.
Set Ambient Light Color

Click the button right of Ambient Light, Color Select Window will appear.



The "Color" section has 32 preset colors. To set color:
1. Choose one of the 32 preset colors
2. Use the cursor to pick a color from the palette
3. Set parameters in the RGB Alpha fields
4. Use the scroll bar to set alpha
Color
Please refer to the Set Ambient Light Color.
 Template Library
Double-click template or choose “Apply” in right-click menu to in light template library to apply
light properties of the template.



11.12.2.3. UV Coordinates

The operation of setting UV coordinates in the three plugins is the same. Switch to the UV
properties tab and set the parameters as needed. See the table below for the meaning of each
parameter.

Planar: enable “Planar”, texture will be planar.
Custom: enable “Custom”, texture will be custom
texture.
Mirror U: after enabling “Planar” enable “Mirror U”,
texture will have mirror U.
Mirror V: after enabling “Planar” enable “Mirror V”,
texture will have mirror V.
Translate X: set texture X position after enabling
“Planar”
Translate Y: set texture Y position after enabling
“Planar”
Translate Z: set texture Z position after enabling
“Planar”
Rotate X: set texture X rotation after enabling “Planar”
Rotate Y: set texture Y rotation after enabling “Planar”
Rotate Z: set texture Z rotation after enabling “Planar”
Scale U: scale texture along U coordinate after
enabling “Planar”
Scale V: scale texture along V coordinate after enabling
“Planar”

11.12.2.4. 3D Transform Property

The 3D transform operations are the same in the three plug-ins. The specific setting of 3D
transformation is introduced as follows.
 Set 3D Transform Parameters
Move timeline to 0 second position, click on “Toggle Animation” buttons of Translate and Rotate
Y.



In 3D Transform tab set parameters of Translate and Rotate Y.

Move timeline to 1 second position, set Translate value as (74,-33,528).



Move timeline to 2 second position, set Translate value as (0,0,0).

Move timeline to the last frame position, set Rotate Y value as720.



In Edit Screen right click the keyframe marker of 1 second and select “Smooth Vertex” from the
context menu.

11.12.3. Preview

 3D Mode



 3D Text

 2D Path To 3D



11.13. 3D Chart

 Operation Flow of 3D Chart

11.13.1. Operation Flow of Still Pie Chart

1. Run 3D Chart Plugin
Choose “3D Chart” button from the drop-down list of “Title Plugin”.

2. Set Chart Properties
In Chart Properties tab click the “Pie” button and select “2D Pie”.

Set Pie Properties parameters and Chart Properties parameters:



In tool bar select “Chart Title” and edit the text.

3. Change Chart Data
Click “F2” or the “Chart Data Editing” button and Chart Data Window will appear. Change data in
the window.



4. Set Chart Miscellaneous Properties
Set Chart Data Color in Chart Miscellaneous Properties Tab

Select row China and column 2012, click the button .

Set color in the popup Select Color Window.

Select row America and column 2012, click the button . Then set color in the popup

Color Select Window.



Select row Germany and column 2012, click the button . Then set color in the popup

Color Select Window.

Set Legend Properties Parameters and Chart Value Parameters in Chart Miscellaneous Properties
Tab
In Legend Properties screen set legend space as 52, Offset X value as -90 and Offset Y value as
-85.
In Chart Value screen set Format as Percentage. And set other parameters as the default.



5. Set Light Properties
In Light Properties tab open Parameters screen. Set Position X value as 47, Position Y value as -31
and Position Z value as -46.



6. Preview

11.13.2. Operation Flow of Dynamic Column Chart

1. Run 3D Chart Plugin

Open the 3D Chart plugin according to the first step of Operation Flow of Still

Pie Chart.
2. Set Chart Properties
In Chart Properties tab, click the “Column and Bar” button and select “3D Clustered Column”.



Set Bar Properties parameters and Chart Properties parameters:

In tool bar select “Chart Title” and edit the text.



3. Create Dynamic Chart
Click “F2” or the “Chart Data Editing” button then Chart Data Window will appear. Edit row
headings and column headings in the window.

Move timeline to 0 second position, click on “Toggle Animation” buttons of Group 1.

In Chart Data Editing Window change data of Group 1.

Move timeline to 1 second position, change data of Group 1 in Chart Data Editing Window.



Click on “Toggle Animation” buttons of Group 2.

Change data of Group 2 in Chart Data Editing Window.

Move timeline to 2 second position, change data of Group 2 in Chart Data Editing Window.



4. Set Axis Properties

In Properties screen click the “Axis Properties” button to open the Axis Properties tab.

In Axis Y Properties screen enable “Axis Plane” and click the button behind, Color

Select Window will appear. Set RGBA as (203, 221, 254, 255).

In Axis X Properties screen enable “Axis Plane” and click the button behind, Color

Select Window will appear. Set RGBA as (255, 255, 255, 128).



Set other parameters as the default.
5. Set Chart Miscellaneous Properties
Set Chart Data Color in Chart Miscellaneous Properties Tab

Select row Group 1 and column All Column, click the button behind.

Set color in the popup Color Select Window.

Select row Group 2 and column All Column, click the button behind. Then set RGBA

value or choose one of the 32 preset colors in the popup Color Select Window.



Set Legend Properties Parameters in Chart Miscellaneous Properties Tab
In Legend Properties screen set legend space as 84, Offset X value as 117 and Offset Y value as 0.

Set Chart Value Parameters in Chart Miscellaneous Properties Tab
In Chart Value screen set Chart Value position as Middle, Offset X value as 1, Offset Y value as 51
and Postfix as K.



6. Set Light Properties
In Light Properties tab open Parameters screen. Set Position X value as 32, Position Y value as 73
and Position Z value as -72.

7. Set 3D Transform Parameters
In 3D Transform tab set Translate value as (-12, 2, 0), Rotate X value -17, Rotate Y value 34 and
Rotate Z value -9.



8. Preview







Chapter Twelve Keyboard Shortcuts

Common Shortcuts
F1 -View Quick Guide
Ctrl+Z -Cancel Operation
Ctrl+Shift+Z -Restore Operation

VisTitle Shortcut Keys

File Command Keyboard Shortcut Remarks

Global
Start Project Ctrl + Shift + N
New Document Ctrl + N
Open Document Ctrl + 0
Save Document Ctrl+S
Save Document Anim Alt+S
Auto Save As Document Ctrl + Shift + S Open independently
Auto Save As Document Anim Alt + Shift + S
Save To NLE Ctrl + Shift + E
Doc Settings Ctrl + Shift + P
Undo Ctrl +Z
Redo Ctrl + Shift + Z
Library F3
Edit View Only F8
Edit View/Effect View Mode F9
Scroll Edit Mode F10
Reset Ul Ctrl + F8
Reset Text Props Ctrl + F9
Reset Shader Style Ctrl + F10
Help F1
System Option Ctrl + Shift + O
Hardware Option Ctrl + Shift + H
Play with CG Hardware or Not Shift + F5
Export Movie Ctrl +E
Tab To Library Ctrl + Tab
About Ctrl + F1
Character Map Alt +T
Special Language Props F4
3D Stereo Adjust Ctrl + F4
Popup Font Property Panel Ctrl +F
Online Notify Ctrl + Shift + F1



Performance Graph Dialog Ctrl + Shift + F11

Layout
Delete Delete
Up Page up
Down Page down
Top Home
Bottom End
Copy Ctrl+C
Cut Ctrl +X
Paste Ctrl + V

Timeline
Delete Delete
Copy Ctrl + C
Cut Ctrl+X
Copy All Shift + C
Paste All Ctrl + Shift + V
Paste New Ctrl +V Ctrl + V establishes a

new effect
Paste To Shift + V Shift + V masks all

chosen effects
Lock L
Visible V
Show Animation Track Only U
Select All Ctrl +A

Select None Esc
Prev.Frame Left
Next Frame Right
Edit Object Previous Position ;
Edit Object Next Position ,
Selection In Shift + Home
Selection Out Shift + End
Home Home
End End
Move Up Ctrl + Page down Support operation to

multiple objectsMove Down Ctrl + Page up
Move Top Ctrl + End
Move Bottom Ctrl + Home
Fit Backspace
Zoom ln =
Zoom Out -
Zoom Selection `



Expand E
Objects Shift Dec. One ,
Objects Shift Inc. One .
Effects Shift Dec. One Ctrl +, Must choose the

corresponding key
frame or effect.

Effects Shift Inc. One Ctrl + .
Keyframes Shift Dec. One Shift + ,
Keyframes Shift Inc. One Shift +.
Objects Trim Out Dec. One J
Objects Trim Out Inc. One K
Effects Trim Out Dec. One Ctrl + J
Effects Trim Out Inc. One Ctrl +K
Trim Objects Out Point to Timeline
Position

Shift + O

Trim Objects In Point to Timeline
Position

Shift +I

Selection In Point Alignment Shift +[ Must choose at least
two objectsSelection Out Point Alignment Shift +]

Selection In Point Align to
Timeline Position

[

Selection Out Point Align to
Timeline Position

]

Play Stop Space
Play Stop In Out Shift + Space
Objects Set Objects Duration Ctrl + D
Make Group Ctrl+G Must choose at least

two objects
Ungroup Ctrl + U
Set In Point I
Set Out Point O
Set Mark Point M
Set Pause Point P
Clear In Point Alt+I
Clear Out Point Alt + O
Clear In Out Point X
Clear All Mark Point Alt + Shift + M
Clear All Pause Point Alt + Shift + P
Goto In Point Q
Goto Out Point W
Goto Prev. Mark Point Shift + Page up
Goto Next Mark Point Shift + Page down
Goto Prev. Pause Point Alt+ Page up
Goto Next Pause Point Alt + Page down
Edit Alt+ E



Keyframe Animation Alt+A
Insert Keyframe Ctrl + Insert
Delete Keyframe Ctrl + Delete
Previous Keyframe A
Next Key frame S
Reset Key frame Ctrl + R
Reset 3D Transform Keyframe Ctrl + Shift + R

Timline
Previous Edit Position Page up
Next Edit Position Page down

EditView
Delete Delete
Lock L
Visible Shift + V
Make Group Ctrl +G
Ungroup Ctrl+ U
Make Path Group Ctrl +P
Text Block Split To Char Alt+C
Text Block Split To Line Alt+L
Copy Ctrl+C
Paste Ctrl +V
Cut Ctrl +X
Select All Ctrl+A
Select None Esc
Fit Backspace
Actual Size 0
Zoom In =
Zoom Out -
Zoom Selection `
Move Up Ctrl + Page up
Move Down Ctrl + Page down
Move Top Ctrl + Home
Move Bottom Ctrl + End
Full Screen F
Screen Center C
Ver. Screen Center V
Hor. Screen Center H
Align Left [
Align Right ]
Align Top Shift +[
Align Bottom Shift +]



Align Hor. \
Align Ver. Shift +\
Same Hor.Space , Must choose at least

three objectsSame Ver. Space .
Boolean Union Ctrl + =
Boolean Subtract Ctrl + -
Boolean Xor Shift + =
Boolean Intersect Shift + -
PathGroup to Shape Alt+P
Mix Normal Ctrl + T
Mix Penetrate Shift + T
Ruler Tab
Guideline G
Quick Text F2 Used to quickly

establish a file
Center Pivot Ctrl + M
Play Stop Space
Play Stop In Out Shift + Space
Export Picture Ctrl + I
Origin Media Object O
Edit Alt+E
Home Home
End End
Selection In Shift + Home
Selection Out Shift + End
Edit Object Previous Position ;
Edit Object Next Position `
Page Up Page up
Page Down Page down
Keyframe Animation Alt+A
Insert Keyframe Ctrl + Insert
Delete Keyframe Ctrl + Delete
Previous Keyframe A
Next Keyframe S
Reset Keyframe Ctrl + R
Reset 3D Transform Keyframe Ctrl + Shift + R



Chapter Thirteen Some Questions and the

Answers

13.1. How to Change Parameter Value

Parameter Type 1

To set parameters:
Method 1: move cursor over the field and left click then enter numbers.
Method 2: move cursor over the field then press the left mouse button and drag right or left.
Parameter Type 2

To set parameters:
Method 1: move cursor over the field and left click then enter numbers.

Method 2: move cursor over the field then press the left mouse button and drag right or left.
Method 3: move cursor over the field then click on “<, >“.
Parameter Type 3



Set parameters by:
Method 1: Dragging the slide marked in green in the image above
Method 2: please refer to Parameter Type 2 about other methods.
Parameter Type 4

Set parameters by:
Method 1: moving cursor over the field then click on “<, >“.
Method 2: Dragging the cursor over the field.
Method 3: moving cursor over the field and left click then enter numbers.
Note: you can double click parameters value in text to make them default.

13.2. How to Enter Special Characters

You can enter special charaters for text object, curve object and morph object.
To enter special characters:
1. After creating a text object, right click in text and choose"Character Map” from the context

menu or press Alt+T.

2. Each font type has the corresponding characters in Chracter Map window. Select a font then
click the desired character in the Chracter Map window.



13.3. How to Convert Character Case

You can convert lower case to upper case by using the Small Caps.
1. Click to select text.

2. Click the “Hide/Show Font AdvProps” button in tool bar then set Small Caps value as 100.



13.4. How to Scale Shader Style Parameter

By using the Scale ShaderStyle Parameter, you can scale all shader parameters of Face, Outline,
Shadow, etc simultaneously.
1. Click the selected object including face, outline and so on.



2. Right click the object then select “Scale ShaderStyle Parameter” from the context menu.

Set Scale Factor parameter in the Scale ShaderStyle Parameter window. The maximum is 200 and
minimum is -200. You must convert the value to percentage, thus the shader parameter value will
triple or reduce twice at most.

Set Scale Factor parameter as 100 then click the “OK” button.

Example:



13.5. Scale Object Data When Video Resolution Is Changed

1. Click the “System Option” button in state bar, the System Option window will appear. Then
select “Default Setting” to open the Default Setting panel.

2. Check “Scale Object Data when video resolution is changed” and change the Scale Object
Data Control Factor parameter value.

3. Click the “Apply” button and then restart VisTitle to apply the change.

13.6. How to Hotkey Process Special Language

After launching VisTitle, you can press F4 to switch current font settings with the special language
font settings.

To set special language font settings:
1. Click the “System Option” button in state bar, the System Option window will appear.
2. Then select “Text Setting” to open the Text Setting panel.



3. Select font settings in the panel.

13.7. Change Arrangement of Timeline Clips

Clip arrangement on timeline is different due to different softwares. For those used to clip
arrangement on timeline in After Effects, you can custom clip arrangement on timeline in VisTitle.
Right click at the head of all tracks to enable or close “Track Layer Matched with Object Layer”
option. The position of objects in editing area won’t change as the option changes.

Objects arrangement and layers are shown as below. Text A, B, C, D correspond to the creating
order as A, B, C, D.



The following pictures are with the clip arrangement on timeline off and on. Close “Track Layer
Matched with Object Layer” option:

Enable “Track Layer Matched with Object Layer” option, (similar arrangement with After Effects).
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